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CAD LEVEL 1- Getting Started with AutoCAD 

1. X-Y Co-Ordinate System, Inputting Points, the AutoCAD Screen, Basic 

AutoCAD Terminology 

2. Assignment 1 Intro to Drawing / Modifying Commands 

3. Assignment 2 More Modifying Commands 

4. Assignment 3 Accurate Input 

5. Selection Sets 

6. Assignment 4 Modifying Commands 

7. Assignment 5 Modifying Commands 

8. Assignment 6 Layers / Dimensioning / Text 

9. Direct Distance Entry and Object Tracking 
10. Changing the Properties of Objects 

CAD LEVEL 2 - Intermediate AutoCAD 

1. Planning a Project - Office Floor Plan 

2. Moving Around Your Drawing - Zoom and Pan 

3. Formatting Text 

4. Plotting From "Paper Space" - View ports And Scaling - Layout Tabs 

5. Introduction to Blocks - Creating and Inserting 

6. Attributes - Non-Graphical Information 

7. Polylines 
8. Hatching - Filling Areas 

CAD LEVEL 3 - Introduction to 3-D 

1. Introduction to 3-D 

2. Isometric Drawing 

3. Working in 3 Dimensions 

4. Viewing 3-D Objects 

5. Basic Wire frame Models 

6. Line Thickness 

7. Regions and 3-D Faces 

a. More about Extruding & Lofting 

8. Revolved Objects 

9. Adding Materials 

10. Primitive Solids 

11. Boolean Operations 

12. Changing From the Was To the Us 

13. Mapping Materials 

14. Creating New Materials 

15. Extra Projects and a Tutorial 

16. Putting It All Together - Model a Building 
17. Introduction to Rendering and Lighting 

 

 



Dot Technologies, Gandhinagar 

 2 

An Introduction to AutoCAD 

Welcome to the world of CAD - In this tutorial you will be learning the basics of 

AutoCAD. The course is designed so that the commands and instructions should work 

on almost any version of AutoCAD, although this version is designed specifically for 

AutoCAD 2007. By the end of this level you will have the skills to develop basic 2D 

drawings and print them out to scale. 

TOPICS IN THIS SECTION: 

 
The X-Y Co-ordinate System - Angular Measurement - Entering Points 

Let's start at the beginning, these things you need to know, or the rest of it won't 

make any sense at all. Make sure you have a very good understanding of this lesson 
before continuing... 

The X, Y co-ordinate system 

Everything that you draw in AutoCAD is exact. It will be more accurate than you will 

ever need it to be. All objects drawn on the screen are placed there based on a 

simple X, Y co-ordinate system. In AutoCAD this is known as the World Co-ordinate 

System (WCS). You must understand this to know how to put things where you want 

them. (3-D work has an added axis, the Z-axis, but this is not covered in this 

lesson.) Below is a diagram showing you how this system works (place your mouse 

on the diagram for more info).  

 

In order to work effectively with AutoCAD, you have to work with this system. Until 

you are comfortable and familiar with it, learning AutoCAD will be more of a chore. 

My experience in teaching is that the better a student is with co-ordinates, the better 

CAD draftsperson they will become... 

Here is how it works: 

AutoCAD uses points to determine where an object is located. There is an origin 

where it begins counting from. This point is (0, 0). Every object is located in relation 

to the origin. If you were to draw a line straight out to the right from the origin, this 

would be considered the positive X-axis. If you were to draw a line straight up, this 

would be the positive Y-axis. The picture above shows a point located at (9, 6). This 

means that the point is 9 units over in the X-axis and 6 units up in the Y-axis. When 

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#xy#xy
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#xy#xy
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#ang#ang
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#entering#entering
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm##
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you are working with points, X always comes first. The other point shown is (-10,-

5). This means that the point is 10 units in the negative X-axis (left) and 5 units in 

the negative Y-axis (down). 

A line has two points, a start point and an end point. AutoCAD works with the points 

to display the line on the screen. Move your cursor over the picture above and you 
will see line drawn from the absolute points of (-10,-5) to (9, 6). 

Most of the time you will not have an indication of where the origin is. You may need 

to draw a line from the endpoint of an existing line. To do this you use relative 

points. These work the same way, but you have to add the @ symbol (shift+2) to tell 
AutoCAD that this next point is relative from the last point entered. 

To review: 

ABSOLUTE POINTS are exact points on the drawing drawing space. 
RELATIVE POINTS are relative to an OBJECT on the drawing space.  

It’s a simple system, but mastering it is the key to working with AutoCAD and is 
explained in more detail further below. 

Angular Measurement 

AutoCAD measures angles in a particular way also. Look at the diagram below and 

then place your mouse on it to see how this is done.  

 

When drawing lines at an angle, you have to begin measuring the angle from 0 

degrees, which is at the 3 o'clock position. If you drew a line at 90 degrees, it would 

go straight up. The example above (when you move your mouse over it) shows a 
line drawn at +300 degrees, or -60 degrees.  

You might not always have an obvious reference point for 0 degrees. Look at the 

example below and place your mouse on the image to find out angle in question. 

 

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#absolute#absolute
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#relative#relative
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm##
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In this example, you are given information about the lines, but not the angle 

AutoCAD needs to draw the line from the start point. What you are given though, is 

(a) the knowledge that 0° is at the 3 o'clock position (b) the knowledge that 180° is 

at the 9 o'clock position and (c) the angle between 180° and the line you want to 

draw is 150°. With this information, you can figure out what angle you need. Here is 
a fool-proof way of getting the angle you need: 

1.) Start at the 0° position and measure counter-clockwise (+) to 180°. 

2.) From 180°, measure clockwise 150°. 

3.) Consider that you just went +180-150 and use that as an equation: +180-
150=30 

4.) Now you can draw your line using polar co-ordinates (discussed below) 

Entering Points in AutoCAD 

You can enter points directly on the command line using three different systems. The 

one you use will depend on which is more applicable for the situation. The first 

assignment will get you used to this. The three systems are as follows:  

ABSOLUTE CO-ORDINATES - Using this method, you enter the points as they 

relate to the origin of the WCS. To enter a point just enters in the exact point as X, 

Y. 

RELATIVE CO-ORDINATES - This allows you to enter points in relation to the first 

point you have entered. After you've entered one point, the next would be entered 

as @X, Y. This means that AutoCAD will draw a line from the first point to another 
point X units over and Y units up relative to the previous point. 

POLAR CO-ORDINATES - You would use this system if you know that you want to 

draw a line a certain distance at a particular angle. You would enter this as @D<A. 

In this case, D is the distance and A is the angle. Example: @10<90 will draw a line 
10 units straight up from the first point. 

The three ways of entering co-ordinates shown above are the ONLY way AutoCAD 

accepts input. First decide which style you need to use, and then enter as shown. 

Remember that X is always before Y (alphabetical). Don't forget the '@' symbol 

when you are entering relative points. Any typing error or omission will give you 

results you don't want. If you make a mistake and need to see what you typed, 

press F2 to bring up the text screen and check your typing. (Press F2 to get back to 

your drawing.) 

More AutoCAD Basics  

Subjects covered in this section:  
Starting Commands - The AutoCAD screen - Terminology 

 

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#polar#polar
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#starting#starting
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#starting#starting
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#starting#starting
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#screen#screen
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#terms#terms
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Icons, Keystrokes and Menus 

There are many ways to do things in most windows programs. AutoCAD is no 

exception. Everyone will develop a way that works best for him or her. In this 

course, we will primarily be working with the keystroke commands. The reason for 

this is because they will work in most AutoCAD versions (including DOS versions), 

and in some other CAD programs. The icons work well, but as you will see, icons can 

be placed anywhere on the screen and can be difficult to find quickly. The pull-down 

menus will access almost all commands, but are a slower way of doing things. 

Example: If you want to draw a line, you can do it a few ways: 

 At the command line type: LINE (or) L and press the ENTER key. 

 Select the line icon from the DRAW toolbar. 

 Select Draw > Line from the pull-down menu.  

All three approaches will do the same thing: prepare AutoCAD to draw a line where 

you tell it.  

AutoCAD is a popular program because it can be customized to suit an individual's 

needs. The toolbars are a good example of this. You can have the toolbars you use 

most often on the screen all the time. You can easily make them go away so that 

you have more drawing space. You can also customize them so you have the most 

common commands on one toolbar. For example, the dimensioning toolbar is one 

that you will not want taking up space on your screen while drawing, but is very 
handy when you're dimensioning your drawing. 

The AutoCAD Screen 
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Move your cursor around the image above to find the names of various areas 
of the screen.  

 Title Bar - This will show you what program you are running and what the 

current filename is. 

 Pull-down menus - These are the standard pull-down menus through which 

you can access almost all commands. 

 Main toolbar - This has most of the standard Windows icons, as well as the 

most common AutoCAD commands. 

 Property toolbar - This toolbar gives a way to quickly modify an object's 

properties, such as layer and line type. 

 Floating toolbar - This is a toolbar that can be moved around the screen, or 

'docked' as the main toolbar is. 

 Drawing space - This is where you draw. You have an almost infinite area to 

draw and this is just a 'section' of the entire space. 

 Scrollbars - These work like in other windows programs. You can also use 

the PAN command to move around your drawing. 

 WCS Icon - This is here to show you which direction positive X and positive Y 

go. The W means you're in the World Co-ordinate System. (It can be changed 

to a User Co-ordinate System.) 

 Status Bar Tray Icons - These icons give you updates on items like 

reference files program updates and print status. 

 Command line - When you type a command, you will see it here. AutoCAD 

uses this space to 'prompt' you for information. It will give you a lot of 

information and tell you where you are in the command. Watch this line 

while learning. 

 Status bar - This allows seeing and changing different modes of drawing 

such as Ortho, Osnaps, Grid, Otrack, etc. 
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Basic AutoCAD Terminology 

Here are some basic terms that you will need to know to begin using AutoCAD. The 
terms in RED have links to give you more information. 

Absolute co-

ordinates  

A way of inputting points based on AutoCAD's origin.  

Acad.dwt  

This is the default template that automatically loads 

whenever you start a drawing session. It can be customized 

to suit your needs.  

Associated 

Dimensioning  

Dimensions that are associated with specific points will 

update as that point is moved.  

Backup file  

AutoCAD can be set to automatically backup your drawing 

and save it. This is a safeguard in case your file gets 

corrupted. It is saved with a .BAK extension  

Block  
A pre-drawn image you can insert in your drawing to save 

time and make your file size smaller.  

Crosshairs  This is your cursor when it is in the drawing space.  

Cursor  
Your cursor will change depending on where it is in the 

program.  

Database  

An AutoCAD drawing file is actually one large database 

containing all the information needed to reproduce the 

objects when the file is opened. Info for layers and 

linetypes, etc is stored in this manner.  

Dialog box  

AutoCAD uses a large number of dialog boxes to get 

information from you. You must know how input the 

information that it asks for.  

Drawing 

template file  

This is a file that contains preset values for frequently used 

settings. AKA a prototype drawing. The file extension is 

DWT.  

Extents  The outer boundaries of the objects you have drawn.  

Grid  
This is pattern of dots displayed on the screen to guide you. 

It can be toggled on and off by pressing the F7 key.  

Grips  Small 'handles' on objects that allow for quick editing.  

Layer  

All objects are drawn on a layer. You can group objects 

(such as electrical) on a single layer and organize your 

drawing.  

Layout Tabs  
A space used for plotting your drawings (formerly called 

Paper Space).  

Limits (Grid)  

A setting to impose an 'artificial' boundary on your drawing 

that sets the area of the grid, and when turned on, limits 

you to drawing in the grid area.  

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#absolute#absolute
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#absolute#absolute
http://www.we-r-here.com/cad/tutorials/level_2/2-5.htm
http://www.we-r-here.com/cad/tutorials/level_4/4-1.htm
http://www.we-r-here.com/cad/tutorials/level_4/4-1.htm
http://www.we-r-here.com/cad/tutorials/level_4/4-5.htm
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Line type  
All objects are drawn with a particular line type. Examples 

would be solid, center, dashed, etc.  

Model space  The drawing space where you 'model' the objects.  

Modify  A generic term used for changing your objects  

Object  
Any item that is in the AutoCAD database. Also known as an 

entity.  

Origin  The (0, 0) point of your current co-ordinate system.  

Ortho mode  

This is a drawing mode that allows you to draw only 

perpendicular lines. It is toggled on and off by pressing the 

F8 key.  

Osnap - Object 

Snap  

This is a method of 'snapping' to certain, precise points on 

an object.  

Path  The specific folder where AutoCAD looks for, or saves files.  

Pick  To select an object by 'left-clicking' on it.  

Plot  Also known as print. To make a hard copy of your drawing.  

Polar co-

ordinates  

A way of inputting points based on distance and angle.  

Property  
Any specific characteristic of an object such as layer, scale, 

line type, start point, etc.  

Relative co-

ordinates  

A way of inputting points based on a starting point.  

Selection set  The current group of objects selected for modifying.  

Snap  

This is a drawing mode that allows you to snap your cursor 

to precise points laid out in a grid pattern. Toggle with the 

F9 key.  

Styles  Formatting that defines the look of text, dimensions, etc.  

Units  

The basic drawing unit set for you drawing. For example, 

you can use inches or millimeters depending on your needs. 

You can also set the precision you want displayed, such 

nearest 1/4", 1/2" 1/64", etc.  

User co-ordinate 

system (UCS) 

 

Modifications made to the World Co-ordinate System (WCS) 

results in a User Co-ordinate System (UCS)  

View  A particular area of your drawing.  

View port  

A separate 'window' on your drawing. You may have more 

than one view port visible to see different areas of your 

drawing at the same time.  

Wizard  
An easy step-by-step instruction set to help you set-up 

certain aspects of your drawing.  

http://www.we-r-here.com/cad/tutorials/level_4/4-3.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#absolute#absolute
http://www.we-r-here.com/cad/tutorials/level_4/4-2.htm
http://www.we-r-here.com/cad/tutorials/level_4/4-2.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#polar#polar
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#polar#polar
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#relative#relative
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#relative#relative
http://www.we-r-here.com/cad/tutorials/level_1/1-5.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#polar#polar
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World Co-

ordinate System 

(WCS)  

This is the common X-Y co-ordinate system that is the 

default. If it is modified, it becomes a User co-ordinate 

System (UCS)  

Zoom  
To view either a smaller section of your drawing (zoom in) 

or a larger section (zoom out)  

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#xy#xy
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#xy#xy
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#xy#xy
http://www.we-r-here.com/cad/tutorials/level_2/2-2.htm
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Introduction to Drawing and Modify Commands 

AutoCAD allows you to have access to a large number of commands. The general 

rule is that you will use 20% of the commands 80% of the time. We will start by 

introducing you to the most common drawing commands. When you combine these 

with the basic modify commands, you will be able to make elaborate drawings quite 
quickly. 

The important thing to remember is that AutoCAD will expect you give it information 

in a very particular order. The most frustrating thing when you begin using this 

program is that you will try to do something, but AutoCAD will 'not work'. In most 

cases, it means that you are trying to input information at the wrong time. This is 
why it is very important to be in the habit of looking at the command line. 

The command line tells you what information AutoCAD requires to continue. 

Your first drawing assignment will be to use the drawing commands in conjunction 

with the co-ordinate system defined above. This is a basic assignment, but it is very 

important to understand how to give the program accurate information. You will use 

the following commands: 

Command  Keystroke  Icon  Menu  Result  

Line  Line / L 
 

Draw > Line  

Draw a straight line 

segment from one 

point to the next  

Circle  Circle / C 
 

Draw > Circle 

> Center, 

Radius  

Draws a circle based 

on a center point and 

radius.  

Erase  Erase / E  
 

Modify > 

Erase  
Erases an object.  

Print  
Print / Plot 

Cntl+P   
File > Print  

Enables the Print/Plot 

Configuration Dialog 

Box  

Undo 

U 

 

(Don't use 'Undo' 

for now) 
 

Edit > Undo  
Undoes the last 

command. 

Assignment #1 - Drawing lines to exact points 

Duplicate the drawing called Assign #1.  

Watch the assignment as a Flash Movie. 

 

Click HERE to see the finished drawing in JPG format. 
Click HERE to download the DWG file.  

http://www.we-r-here.com/cad/tutorials/level_1/links/assign_1.swf
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_1.jpg
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_1.dwg
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You will not have to worry about the title block or text, or dimensioning.  

Make sure you are comfortable with the co-ordinate system as explained in Lesson 

1-1. When you are finished this assignment, check the printed drawing with a scale 
ruler. All lines should measure up exactly if all went well. 

Steps:  

Start AutoCAD and a new drawing by using the menu option File > New. You will 

see a dialog box open that asks you to select a template drawing to use (as shown 
below): 

 

 

Select the "acad.dwt" template file (more about those in a later lesson) and press 
the Open button to continue to the drawing screen.  

Once there, type in Z <ENTER> E <ENTER> this will zoom into to the extents of the 

drawing area and make it easier to see what you are drawing (NOTE: nothing will 
appear to happen). 

For all lessons on this level, make sure that you do not have Dynamic Input 

turned on. You can check this on the status bar. Make sure (the DYN 

button) isn't depressed. This is a new system of entering points that will be covered 

in a later lesson, but personally I find them less convenient and can affect you 
computer's resources.  

Start the LINE command (as explained in the table above) and draw a line from 1, 2 

to 3, 2 to 3, 4 to 1, 4 Press enter after each point. (*Remember to watch the 

command line as you do this.) For the last line, you can either type in 1, 2 or C to 

close the line back to the first point you entered. You have just drawn a 2" square 
using absolute co-ordinates.  

If you make a mistake, you can use the undo icon, press U or press CTRL+Z. 

You can also use the ERASE command to get rid of lines you don't want. 

Next draw a similar box using relative co-ordinates. Start the LINE command and 

begin at point 4.5,2. From there draw a line two units to the right by typing @2,0 

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm
http://www.we-r-here.com/cad/tutorials/level_4/4-1.htm
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(this means 2 units in the X direction, 0 units in the Y direction based on the last 

point you entered). Next type @0, 2 then @-2, 0 then @0,-2 to finish the box. 

(Remember to press enter after each point.)  

Now erase the last box you just drew. Start the ERASE command and then select 

the lines you want to erase. Then press <enter>. Now redraw the box for more 
practice! 

Draw a third box using polar co-ordinate input. Start the LINE command and 

begin at point 8, 2 then enter. Type @1<45 to draw the first line. Next enter 

@1<135 then @1<225 then @1<315 (or C to close). What you have just done is 
drawn a line 1 unit long at 45o, then another at 135o and so on.  

Start the CIRCLE command and add a circle that has a center point at 7, 6 with a 
radius of .75 (Watch the command line for instructions).  

To finish the drawing, try putting a 10"x7" border around the page starting at 0, 0 
using the any of the methods shown above (relative, absolute or polar). 

When you have done the assignment, print (or plot) it out. To do this, bring up the 

plot dialog box using any method explained above (plot <enter> will work). Set it 

up to print as shown below. Follow these steps for a successful plot (see diagram 
below): 

1. Select your printer - laser or inkjet will work fine.  

2. Select the paper size - "Letter" (8-1/2" x 11") is needed in this case. 

3. For the "Plot Area", select "Extents" - that will plot everything you drew. 

4. Select the checkbox to "Center the Plot" on your sheet of paper (looks 

better). 

5. If "Fit to Paper" is selected by default, uncheck it and select a scale of 1 inch 

to 1 paper unit. This will make your printout 'life-sized'. 

6. Now Preview your drawing. I strongly recommend that you preview EVERY 

drawing you will ever draw in AutoCAD - a lot can go wrong, so you don't 

want to waste paper (especially when you're using expensive 3'x4' sheets!).If 

your preview looks good, cancel out of it by clicking on the large red X icon. 

7. If you're sure that everything's ok (this is where good habits begin), press the 
OK button.  



Dot Technologies, Gandhinagar 

 13 

 
 

Note: You may have to change the paper size in your printer (Use the Windows 

printer settings to do this.) You may also have to change the rotation or origin of the 
plot. Check the Landscape radio button in the Drawing Orientation section. 

If everything worked out, you should be able to measure your drawing and have it 

exactly the way you drew it (a couple of 2" squares, an angled 1" square and a 1-
1/2" circle). 

Save your drawing as you would any other Windows file? CNTL+S will bring up the 
Save or save as dialog box.  

If you want to check your input, click HERE to see the commands needed to 
complete this assignment. 

This assignment has given you a basic introduction to drawing using a variety of 

methods. Once you have completed the assignment, practice these methods, as you 
will be using them often. 

Your boxes should match the drawing example. They will be the same size and on 

the same place in the drawing. If you have a ruler, you will see that your lines are 

life-size (1:1). From these basic concepts, you can now draw lines anywhere if you 

know where they should go. The next lessons will add to these commands. As you 

get used to the AutoCAD interface, you will find it easier and easier to learn the new 

commands. But for now, mastering the co-ordinate systems, inputting 
commands and reading the command line should be your priority.  

http://www.we-r-here.com/cad/tutorials/level_1/links/l1_comm.htm
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Basic Drawing Skills 

The previous lesson dealt with drawing commands. This lesson will introduce the 

common modifying commands. In AutoCAD, you may use modifying commands 

more often than drawing commands. Now that you know that basics, here's some 

more commands to add to your collection. 

Command Keystroke Icon Menu Result 

Rectangle  

RECTANGLE /  

REC   

Draw > 

Rectangle 

Draws a rectangle after 

you enter one corner 

and then the second. 

Multi Lines MLINE / ML 
No 

Icon  

Draw >  

Multiline  

Draw parallel lines 

based on the 

parameters you define.  

Trim  TRIM / TR  
 

Modify > Trim  
Trims objects to a 

selected cutting edge.  

Extend  EXTEND / EX  
 

Modify > 

Extend  

Extends objects to a 

selected boundary 

edge.  

Offset  OFFSET / O 
 

Modify > 

Offset  

Offsets an object 

(parallel) by a set 

distance.  

Object 

Snaps  

OSNAP / OS / 

F3  

CLICK 

 

Tools > 

Object Snap 

Settings  

Brings up the OSNAP 

dialog box.  

Assignment #2 - Modifying Commands 

The purpose of this assignment is to use the commands learned in the previous 
lesson and learn some new ones. 

Duplicate the drawing called Assign_2.  

Click HERE to download the DWG file. 

 

Once again, do not worry about title blocks, text or dimensions, draw only what is in 
yellow. 

Start AutoCAD and begin the the drawing by opening up the template file like you 
did in Lesson 1-2.  

Draw a LINE from 1, 2 to 3, 2 to 3, 4 to 1, and 4 (*Remember to watch the 

command line as you do this.) For the last line, you can either type in 1, 2 or C to 

close the line back to the first point you entered. These are absolute co-ordinates. 
Make sure you understand what the points you’re just entered represent.  

http://www.we-r-here.com/cad/tutorials/level_4/4-2.htm
http://www.we-r-here.com/cad/tutorials/level_4/4-2.htm
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_2.gif
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_2.dwg
http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm#start
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Draw the next square using the RECTANGLE command. A rectangle is created by 

specifying 2 points to represent the opposite corners. Enter the first point as 4.5,2 

and then make the opposite corner 2 inches over and 2 inches up @2, 2 using 

relative co-ordinates. This is much faster and also makes the square one object 
and not 4 separate lines.  

ERASE the rectangle. You will see that all of it is gone with one pick. Redraw it and 
continue. 

Draw the third box using the MULTILINE command. This box is 1-1/2" square. The 

following steps are what you will see on the command line. Before drawing the lines, 

you have to set the SCALE to 0.15"(distance between the lines) by typing 'S'. Then 
set the JUSTIFICATION (offset origin) by typing 'J'. 

Command: ml <enter>  

MLINE 

Current settings: Justification = Top, Scale = 1.00, Style = STANDARD 

Specify start point or [Justification/Scale/Style]: s <enter> 

Enter mline scale <1.00>: .15 

Current settings: Justification = Top, Scale = 0.15, Style = STANDARD 

Specify start point or [Justification/Scale/Style]: 8,2 <enter> 

Specify next point: @1.5,0 <enter> 

Specify next point or [Undo]: @0,1.5 <enter> 

Specify next point or [Close/Undo]: @-1.5,0 <enter> 

Specify next point or [Close/Undo]: @0,-1.5 <enter> 
Specify next point or [Close/Undo]: <enter> 

To review what you just did, you started the command, and then set the scale 

(distance between the lines) to .15 units. Then you just drew the rectangle using 

relative co-ordinates. 

Erase the multilane rectangle you just drew. Notice that when you hover over the 

rectangle, it will turn to a dotted line. This means that it is highlighted as the object 

that will be selected if you pick at that moment. In highly detailed drawings, this is 
very handy.  

Draw it again as shown below and note the subtle difference from the first one you 

drew. 

Command: ML <enter>  

MLINE 

Current settings: Justification = Top, Scale = 1.00, Style = STANDARD 

Specify start point or [Justification/Scale/Style]: s <enter> 

Enter mline scale <1.00>: .15 

Current settings: Justification = Top, Scale = 0.15, Style = STANDARD 

Specify start point or [Justification/Scale/Style]: 8,2 <enter> 

Specify next point: @1.5,0 <enter> 

Specify next point or [Undo]: @0,1.5 <enter> 

Specify next point or [Close/Undo]: @-1.5,0 <enter> 
Specify next point or [Close/Undo]: C <enter> 
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The difference is that instead of drawing to the last point, you used the C (close) 
option to complete the rectangle. The difference is shown in the drawing below. 

 

This is an example of why you have to look at the command line as you work. As 

soon as you start the command, you have choices available. Whenever you see this 

come up, if you want to change anything, you just type the CAPITOL letter of the 

option. For example, if you want to undo the last point, you would type u at this 

point. For this assignment you only changed the scale. After you have completed the 

assignment, try different settings for this command. Use your AutoCAD help option 

to see what these options control. (NOTE: I don't normally use Multilines while 

drawing as I don't have complete control over both the inner and outer lines. On the 

other hand, Multilines can be great for drawing quick offset lines. Also, they cannot 
be trimmed (you have to explode them first).  

Draw a line from 2, 5 to 2, 6.5 draw another line from 1, 6 to 3, 6 you should now 

have two perpendicular lines. What you want to do is trim off the top of the vertical 

line and creates a T. 

Start the TRIM command. It will first ask for a cutting edge. Select the horizontal 

line and press <ENTER>. It will now ask for the object to be trimmed. Select the 

vertical line anywhere above the horizontal (cutting) line and press <ENTER> to 
finish the command. 

This is what you saw on the command line: 

Command: TR <enter> TRIM 

Current settings: Projection=UCS, Edge=None 

Select cutting edges ... 

Select objects: <Select the Horizontal line>1 found 

Select objects: <enter> 

Select object to trim or shift-select to extend or 

[Fence/Crossing/Project/Edge/eRase/Undo] : <Select the vertical line> 
Select object to trim or shift-select to extend or [Project/Edge/Undo] : <enter> 

Once again, it is important to keep your eye on the command line as it will guide 
through most commands. 

Draw a LINE from 4, 6.5 to 6, 6.5 Draw another line from 5, 5 to 5, 6 what you 

want to do now is extend the vertical line up to the meet horizontal line. Start the 

EXTEND command. AutoCAD asks for a boundary edge; select the horizontal line 

press <ENTER>. It then asks for an object to extend; select somewhere in the top 

half of the vertical line. Press <ENTER> to end the command. Your command line 

history should match what is printed below. 

Command: EX <enter> EXTEND 

Current settings: Projection=UCS, Edge=None 

Select boundary edges ... 
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Select objects: <Select the horizontal line> 1 found 

Select objects: <enter> 

Select object to extend or shift-select to trim or [Fence/Crossing/Project/Edge/Undo] 

: <Select the top half of the vertical line> 
Select object to extend or shift-select to trim or [Project/Edge/Undo] : <enter> 

Draw a CIRCLE with a center point of 7.5, 5.5 with a radius of .5 Now you will use 

to offset command to make another circle 1/4" larger. Start the OFFSET command 

(watch the command line) and enter .125 as the offset distance. Now select the 
circle and pick anywhere outside the circle. Press <ENTER> to end the command. 

Object Snaps  

Suppose you want to draw a line from the center of the circle to the middle of the 

vertical line you extended earlier. AutoCAD has a feature that makes this very easy. 

These are the Object Snaps (or Osnaps "Oh-Snaps"). Type OS <ENTER>. You will 

see this dialog box appear. 

 

You may also see a toolbar with these Osnaps as shown below. 

 

ICON SETTING   ICON SETTING 

 
Endpoint   

 
Perpendicular 

 
Midpoint   

 
Tangent 

 
Center   

 
Nearest 

 
Node   

 
Apparent Intersection  

 
Quadrant   

 
Parallel 

 
Intersection   

 
None 

 
Extension   

 
Osnap Setting 

http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#end#end
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#per#per
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#mid#mid
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#tan#tan
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#cen#cen
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#nea#nea
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#node#node
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#qua#qua
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#qui#qui
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#int#int
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#non#non
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#ext#ext
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#osset#osset
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Insertion 

Point 
   

 
Temporary Tracking Point 

    
 

Snap From  

You may select whichever points you want to 'snap' on an object. Here is a list of 

your options. Followed by the command entry to invoke the needed Osnap. 

Endpoint - snaps to either the beginning or the end of an object such as a line - 
END 

Midpoint - snaps to the exact middle of a line or an arc - MID 

Center - snaps to the center-point of a circle or arc - CEN 

Node - snaps to 'nodes' (not covered in this course) - NOD 

Quadrant - snaps to any of the four quadrants of a circle - QUA 

Intersection - snaps to the point where two object cross - INT 

Extension - Snaps to the phantom extension of an arc or line - EXT 

Insertion - snaps to the insertion point of an object (such as a block or text) - INS 

Perpendicular - will snap so that the result is perpendicular to line selected - PER 

Tangent - snaps to create a line tangent to a circle or arc - TAN 

Nearest - will find the closest point an object and snap to that point - NEA 

Parallel -Snaps parallel to a specified line - PAR 

None - temporarily turns off all Osnaps. (Pressing your F3 Key is quicker) - NON 

Osnap settings - opens the Osnap dialog box. 

Temporary Tracking - Creates a temporary tracking point (see Object Tracking). 

From - Allows you to select a point, and then denote a new location 'from' that point 

using relative co-ordinates. This can save you the time of drawing (and erasing) 

construction lines.  

Note: Beside each checkbox is a symbol. That symbol will show up on the screen 

when you have found a valid snap point. (An endpoint will show a small square). If 

you select the "Options" button, you can change the aperture size and the color of 

the Osnaps. Depending upon the background you are drawing on, this may be 

needed.  

http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#ins#ins
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#temp#temp
http://www.we-r-here.com/cad/tutorials/level_1/1-3.htm#from#from
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1. Check off the boxes as shown in the dialog box above (Object Snaps On, 

Endpoint, Midpoint, and Center) and press OK. 

2. Begin the LINE command. Move your cursor around the screen and you'll see 

that as you get close to an object, it will 'snap' to one of the points that you 

had checked off in the dialog box. Place your cursor on the circle (not the 

middle of the circle) until you see a small purple circle appear at its center. 

Left-click to make this the start point of the line. Move the cursor towards the 

middle of the vertical line until you see a small triangle appear. (Remember 

this is the symbol for 'midpoint'). When you see it left-click to accept this as 

your endpoint. Press <ENTER> to end the line command. 

3. Save your drawing. 
4. Print your drawing with the same settings as in Assignment #1. 

TIP: Before you select the Osnap you want, you can press the TAB key on your 
keyboard to cycle through the available Osnaps in the area of your cursor.  

When you have finished the assignment, continue practicing with the commands 

until they are mastered. These are common commands that you will use in everyday 

drafting.  

http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm#print
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Accurate Input 

Now it's time to see if you were paying attention in the first lesson. In this lesson you 

will complete the drawing that will test your knowledge of drawing accurately using 

different types of precision input. 

You can download the DWG file HERE and view the image HERE  

Print the file out and try to reproduce it. Start at the bottom left corner. Use the 

drawing tools you have learned in the previous lessons. You will have to use a 

combination of absolute, relative, and polar co-ordinate input.  

 

1. Open AutoCAD and set up the drawing as you have for the previous 

assignments. 

2. Complete the assignment by drawing it accurately using the dimensions 

provided. 

3. If you make an error along the way, remember that you can use your 

ENDPOINT Osnap to begin where you left off. 

4. Save your drawing. 
5. Print your drawing using the guidelines given in the previous assignments. 

Click HERE to check the command line input for this drawing. 

As mentioned earlier, AutoCAD is accurate. It is up to the user to ensure that they 

give the proper input to make sure that the drawing is accurate. It can be extremely 

costly to make mistakes with what seem to be 'minor' errors in accuracy.  

By this point in the tutorials, you should able to do the above drawing without 

referencing other materials. If this isn't the case, you should review the previous 
lessons.  

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_3.dwg
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_3.gif
http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm#print
http://www.we-r-here.com/cad/tutorials/level_1/links/l3_comm.htm
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Selecting Objects in AutoCAD 

By now you have probably seen a colored rectangle appear on your screen when you 

left-click and the move the crosshairs around. You'll learn all about these in this 

lesson. AutoCAD uses what's called a selection set to allow you to group objects 

together and then modify them. For example, if you want to erase several lines, you 

could press E <ENTER>, pick on the line, press <ENTER> again and repeat until 

you're done. Another way would be to press E <ENTER>, and then pick the lines one 

by one until they are all selected, and press <ENTER>. By selecting a group of 

objects, you have created a selection set. Whenever you want to modify an object, 

and are asked by AutoCAD to "select objects" you can create a selection set and 

then apply the command.  

REMEMBER TO PRESS ENTER WHEN YOU ARE FINISHED SELECTING THE OBJECTS 
YOU WANT. 

There are also a few other ways to create a selection set. The most common way is 
to use a window.  

There are two very different types of windows you can use.  

One is a 'crossing window' and the other is a box. If you create the window from 

right to left, you make a crossing window. This means that any object that crosses 

the border of the window is added to the selection set. This is shown as a green 

rectangle with a dotted outline on the screen. If you create the window from left to 

right, you create a box. Using this method you'll add only the items that are 

completely within the box. This is shown as a blue box on the screen. The 

difference is very important.  

To summarize: 

Direction Called  Display Effect 

Right To 

Left 

Crossing 

Selection  
Blue 

Selects Any Object That Either 

Crosses The Boundary Or Is Inside 

It 

Left To 

Right 
Window Selection  

Green  

(With A 

Dotted 

Outline)  

Selects On Objects That Are 

Completely Within The Box  

There are other ways to select objects and here a few of the more common ways. 

These can also be used in combination. 

REMOVE - by typing R when asked to select objects, AutoCAD will select change to 

allow you to remove objects from the selection set. You can also remove individual 
objects by pressing the Shift Key when selecting (known as a 'shift-select') 
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LAST - by typing L when asked to select objects, AutoCAD will select the last object 

that you created. This is handy if you create something and want to move or modify 

it right away. 

PREVIOUS - by typing P when asked to select objects, AutoCAD will select the 

previous selection set. This is used if you select a few objects, modify them and then 
want to modify them again. 

FENCE - by typing F when asked to select objects, AutoCAD allows you to draw a 

series of lines (called a fence) to select objects. This is convenient if you want to 

select a group of lines to be trimmed to a single cutting edge. 

CROSSING POLYGON - typing CP when you are selecting objects give the ability to 

create a crossing polygon for object selection. This is similar to a crossing box, but 

you can pick points on the screen to create a polygon. By default, this is a crossing 

polygon; therefore any objects that cross the polygon will be added to the selection 

set. 

CROSSING WINDOW - typing CW when you are selecting objects give the ability 

to create a crossing window for object selection. This is similar to a crossing box, but 

you can pick points on the screen to create a polygon. This is a crossing window; 

therefore any objects that are completely within the polygon will be added to the 

selection set. 

CYCLING - When are ready to select objects, hold down the Shift key on your 

keyboard and then press the Space Bar when your mouse is on top of overlapping 

objects. Repeatedly press the Space Bar until the one object you want to modify is 

highlighted. Then pick with the mouse. This is a good approach if you have many 

objects in a small area. 

To unselect everything you have selected, you just press the escape key on your 
keyboard.  

For practice, open one of your previous drawings and try selecting objects using all 

of the methods described above. You need to quickly select objects in AutoCAD to be 
a good operator.  
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More Modifying Commands 

In this assignment you will be adding some more common commands to your 
collection. All of these commands are ones that you will use on a regular basis.  

Command  Keystroke  Icon  Menu  Result  

Move  Move / M  
 

Modify > 

Move 

Moves an object or 

objects 

Copy  Copy / CP  
 

Modify > 

Copy 

Copies object(s) once or 

multiple times 

Stretch  Stretch / S  
 

Modify > 

Stretch 

Stretches an object 

after you have selected 

a portion of it 

Mirror  Mirror / MI  
 

Modify > 

Mirror 

Creates a mirror image 

of an object or selection 

set 

This is a short assignment to show you how these commands are used. You will 

recreate the drawing called Assignment #4. 

 

Click HERE to see the file in GIF format. 

Click HERE to download the DWG file. 

Start up AutoCAD and set up your drawing as you have in the previous assignments. 

Turn on your Endpoint Osnap.  

This time draw the border first. Draw a 10" wide by 7" high rectangular border using 
any method. The bottom left corner must be at 0, 0 

Draw a 2" wide by 3" high rectangle using the  
RECTANGLE command. The bottom left corner must be at 0, 0 

Notice that the small rectangle and the border are overlapping each other at the 

bottom left of your drawing. What you want to do is move the small rectangle over 
1" and up 1" so that it is away from the border.  

To do this, start the MOVE command by typing in either m or move <ENTER>. 

Select all the lines of the rectangle using one of the selection methods described 

earlier. Press <ENTER>. Now AutoCAD asks for a "base point or displacement". 

What it needs is a reference point. Click on the bottom left corner of the rectangle. 

AutoCAD now asks for a 'second point of displacement'. What it needs to know 

now is how far you want to move it. This is a great time to use relative co-ordinates. 

In this case, you want to move it 1" over and 1" up. So type @1, 1<ENTER> to 
achieve this. The rectangle will automatically move to its new location. 

http://www.we-r-here.com/cad/tutorials/level_1/links/assign_4.gif
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_4.dwg
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#relative


Dot Technologies, Gandhinagar 

 24 

Now you want to copy this rectangle 3" over to the right. The copy command is very 

similar to the move command. (The only difference is that the copy command leaves 

an original behind.) 

Start the COPY command. You will be asked to select objects. Select the rectangle 

you just moved. AutoCAD now needs the "base point or displacement" just like in 

the move command. Once again, select the bottom left corner of the rectangle. Once 

you've done this, you need to tell AutoCAD what the second point of displacement is. 

Since you want to move the rectangle over 3" to the right, type in @3, 0 <ENTER> 
the rectangle has now been copied 3" over.  

But the rectangle is not as tall as the one in the sample drawing; the sample 
drawing's rectangle is 1" taller. To modify this, you'll use the stretch command.  

Start the STRETCH command by typing S <ENTER>. AutoCAD now makes you 

select objects by using a crossing window or crossing polygon. You're going to use a 

crossing window. Remember from the Lesson 1-5 that you make a crossing 

window by creating it from the right to left. Left-click just a bit above and to the 

right of the top right hand corner of the new rectangle (P1). Move your crosshairs 

down and to the left until your (dotted) crossing window covers the top half of the 

rectangle completely and then left click again (P2). You'll see that the objects are 

highlighted now. Press <ENTER> to accept this. Next you're asked for that now 

familiar base point. Pick on the top left corner of the rectangle. Now give AutoCAD 

the second point of displacement. In this case, you want to stretch the rectangle 1" 
up, so type @0, 1 <ENTER> to do this. The rectangle is now 1" taller.  

 

The goal when selecting objects to stretch is to draw the window over the vertices or 

points that you want to stretch. If you miss a corner, you will change the shape of 
the rectangle. So always be aware of which points need to be stretched.  

Next you want to draw the polygon on the right side. To do this, you will draw the 

three lines on the left side first and then mirror those lines over to the right side. 

Draw the 3 lines any way you like (hint: use absolute co-ordinates).  

Once they are drawn, begin the MIRROR command. Select the three lines (press 

<ENTER>) Now you are asked for the first point of the mirror line. With your 

endpoint Osnap turned on, pick the end of the line at 8, 2. Now you are asked for 

the second point. Select the point on the line at 8, 5. Once you've done this, 

AutoCAD wants to know if you want to delete the old objects. In this case you don't, 

so accept the default by pressing <ENTER>. Note: In general, the mirror line will be 
half-way between the object the you are mirroring and where you want it to be.  
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The assignment is now complete. Review what you have done and practice on these 
commands. Save and print your assignment. 

http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm#print
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More Modifying Commands 

   

Now it's time to learn a few more commands. Like all of the commands learnt so far, 

these too will be ones that you will use regularly. 

Here are the commands that you will be learning in this lesson. 

Command Keystroke Icon Menu Result 

Rotate  Rotate / RO  
 

Modify > 

Rotate 

Rotates objects to a 

certain angle 

Fillet  Fillet / F  
 

Modify > Fillet 
Creates a round corner 

between two lines 

Chamfer Chamfer / CHA  
 

Modify > 

Chamfer 

Creates an angled 

corner between two 

lines 

Array  Array / AR  
 

Modify > 

Array 

Creates a repeating 

pattern of the selected 

objects 

Once again you will recreate a drawing. This one is called Assignment #5.  

 

Click here to see the GIF format file.  

Click here for the DWG file.  

 

Follow the steps shown carefully. As these commands require a little more input, 

make sure that you keep an eye on the command line. You will be asked to 

provide information throughout the commands. 

Start up AutoCAD and load the acad.dwt template like you have for the other 
lessons. 

Start by drawing a horizontal 10" X 7" border with the bottom left corner at 0, 0  

Draw a rectangle 1" wide by 3" tall with the bottom left corner at .75, .75  

You are now going to rotate this rectangle 90° clockwise. 

Start the ROTATE command. AutoCAD asks you to select objects. Select all parts of 

the rectangle and press <ENTER>. Now you must indicate a 'base point'. Think of 

this as a pivot point around which the rectangle will rotate. In this example, you 

want to select the bottom right corner (remember to use your Osnap). Once you've 

selected the base point, the command line shows rotation angle or [Reference]: This 

means that 'Rotation angle' is the default, so type in the angle you want to rotate the 

object. Think about how AutoCAD measures angles. Looking at your rectangle and 

the one on the assignment sheet, you'll see that you want to rotate the rectangle 

clockwise or: -90 degrees. Enter that number and press <ENTER>.  

http://www.we-r-here.com/cad/tutorials/level_1/links/assign_5.gif
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_5.dwg
http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm#start
http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#ang
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Command: RO <ENTER> 

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0 

Select objects: <Select the Rectangle> 1 found 

Select objects: <ENTER> 

Specify base point: <PICK BOTTOM RIGHT CORNER OF THE RECTANGLE> 

Specify rotation angle or [Reference]: -90 <ENTER> 

 

The rectangle is now been rotated -90 degrees from its original position. Picking 

different base points will give you different results. Undo the last command. Try a 

few different combinations of base points and angles to see what results you get. 

When you are done practicing, get the rectangle back to the position it was at the 
end of previous step. 

Make a COPY of the rectangle 2" above the first one (remember your relative co-
ordinates).  

Now you're going to modify the second rectangle so that it has rounded corners. 

Start the FILLET command. Look at the command line. It will look something like 

this:  

Command: F <ENTER> FILLET 

Current settings: Mode = TRIM, Radius = 0.0000 
Select first object or [Undo/Plotline/Radius/Trim/Multiple]:  

AutoCAD first shows you what the current fillet radius is (0.0000). This will be the 

last value that was used. Once it's changed, it will keep the new value in memory. 

The next line shows you what options you have in this command. Remember that the 

Capitol of each option selects that particular option. What you want to do is change 

the fillet radius to 3/8" (or .375). To do this you have to type R <ENTER>. When you 

type this AutoCAD will give the chance to enter a new fillet radius. At this point enter 
.375 and press <ENTER>.  

The fillet radius is now .375 (which is what you want). The default option is Select 

first object. Select the left side of the top rectangle (yes, the whole rectangle will 

highlight if you drew it as a rectangle). AutoCAD now asks you to select second 

object. Select the top line and AutoCAD will make a smooth round corner with a 
radius of .375. AutoCAD automatically ends the command at this point.  

Restart the FILLET command and do this to the remaining corners so that you 
have an object similar to the example. 

Copy the first rectangle to a point 4-1/2" above. Now you will use the chamfer 
command to give this rectangle sharp corners.  

Start the CHAMFER command. Look at the command line. It should look like this:  

Command: CHA <ENTER> CHAMFER  

(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 

Select first line or [Plotline/Distance/Angle/Trim/Method]: D <ENTER> 
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Specify first chamfer distance <0.5000>: .375 <ENTER> 

Specify second chamfer distance <0.3750> : <ENTER> 

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple] : <select 
one side of the rectangle>  

This is very similar to the fillet command. You have several options available. Want 

you want is an even 45 degree angle 3/8" in from the corner. Like the fillet 

command, you first have to tell AutoCAD what distance you want. To do this, type D 

to select the Distance option. The command line now looks like this: 

Specify first chamfer distance <0.5000>: .375 <ENTER> as your first distance.) The 

command line now asks for the second distance. AutoCAD will automatically change 
the default of the second distance to match the distance you entered for the first. 

Specify second chamfer distance <0.3750>: (Press <ENTER> to accept this) 

You will then be asked to select first line. The chamfer command works just like the 

fillet command. Select the line on the left of the top rectangle. (Don't worry if the 

entire rectangle highlights.) When prompted to select second line: select the top line. 

You will now have a perfect sharp corner at a 45 degree angle 3/8" in from the 
corner. Do this to the rest of the corners. 

Now look at the assignment sheet and notice the group of six rectangles on the 

bottom right. You could draw each one individually, but AutoCAD has a command 

that will allow you to draw one, and it will make the others.  

Create a rectangle that is 1/2" square with the bottom left corner at 6, 1.5 (absolute 
points).  

Start the ARRAY command. Look at the dialog box shown below:  

 

When confronting a new dialog box, I recommend that you look for what is needed 

from the TOP DOWN to the bottom. This is a great example. 

1. Choose the radio button for "Rectangular Array". This will array the object in 

a row/column arrangement.  

2. Next select the object you want to array, by picking on the button in the top 

right corner. (Press enter when done)  

3. Enter the number of rows (going across the page) and column (running up 

and down the page).  
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4. Enter the Row offset. This is this from the bottom left of the original 

rectangle, to the bottom left of where the first copy will go.  

5. Enter the Column offset  

6. Pick the Preview button to see the array before committing. 

 

 

If the array is correct (check the sample drawing), press the "Accept" button. If you 

need to change anything, press the "Modify" button, make your changes in the 
dialog box and preview again. 

Now you are going to use the ARRAY (polar) command to create the shape in the 

top right corner of the assignment. 

Start by making a CIRCLE with a center point of 7.5,5.5 and a diameter of 1.5 Next 

make a LINE from the center of the circle going 1" to the right (remember your 
relative input and Osnaps).  

Start the ARRAY command. When asked to select objects, pick the line you just 
drew.  

 

Examine the dialog box above. Remember to start from the TOP. In this case, you 

have to select your objects and select a Center Point for the array. (Select the center 
of the circle.) 

Save and print your drawing. 

So far in seven lessons, you have learned many of the common commands in 

AutoCAD. It may not seem like a lot, but the idea is to become fluent in them. It 

should be second nature to run these commands. With practice, you won't the 

command line to help you along. Think of the first time you drove a car with a 

manual transmission. After time, it got smoother, didn't it? I can't stress enough how 
important practice is during these early lessons.  

http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm#print
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Layers and Dimensioning 

Now that you've learned a lot of the drawing and modifying commands, it's time to 

go to the next level. This lesson will introduce you to text, dimensioning and the 

concept of layers. What you will do is take one of your previous assignments, save it 

to a new name and then add text and dimensions to it. These are the commands 
you'll be learning. 

Command Keystroke Icon  Menu Result 

Layer  Layer / LA  

 

Format > Layer Starts the Layer and Line 

type property dialog box 

Text  Text No 

Icon  

Draw > Single 

Line Text 

Creates a single line of 

text 

Dimension Dim Many  Dimension > 

(pick one) 

Dimensions previously 

drawn objects 

Scale Scale / SC 

 

Modify > Scale Proportionately resizes (or 

scales) objects 

Begin by opening up Assignment #5 from your CAD folder. 

Using the SAVE AS option, immediately save it under the name Assign6.dwg 

Click HERE for the GIF version of the file.  
Click HERE for the DWG version. 

The first thing you want to do is create three layers. Layers are used to organize 

drawings. Imagine a large project for a high-rise tower. The designers would create 

layers for the electrical, plumbing, landscape and more. It is necessary to control the 

drawing and turn some layers off and view only the ones you want. This is one 

reason why layers are needed. But if you were to use AutoCAD professionally, every 

drawing you dealt with would have layers.  

You will be creating a layer for the dimensions, one for the lines (objects that were 

drawn) and another for the text. Start the LAYER command (LA). This will bring up 

the Layer Properties Manager (shown below). We'll cover the things that are used 
most often in this lesson.  

http://www.we-r-here.com/cad/tutorials/level_1/links/assign_5_no_dims.dwg
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_6.gif
http://www.we-r-here.com/cad/tutorials/level_1/links/assign_6.dwg
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Looking at the Dialog Box, you will see a lot of information. Notice the button beside 

Make Current on it. Below it is the name of the current layer you are drawing on. 

The main window gives you information about each particular layer. At this point, 

you want to be concerned with the 'Name', 'On' (light bulb) and 'Color' (colored 
square) columns as well as the 'New' button.  

Now you have the dialog box on your screen, click the 'New' button. This will create 

a new layer and give you an opportunity to name it. Name this layer TEXT. Click on 

the small box towards the right and select yellow for the color. Create another layer 

and call this one DIM (for dimensions), and make its color red. Finally, create a 

third layer and call it OBJECT and make its color green. You have just created three 

new layers in your drawing. Highlight the TEXT layer and then press the 'Make 

Current' button. This makes the TEXT layer current and anything you draw will be 

placed on that layer. Your Dialog box should look like the one above. If it does, press 
OK to close the dialog box. 

More about Layers  

In the Layer Properties Manager, you will notice that each layer can have a number 
of specific properties.  

 

 Status: Displays the current state of the layer. In this example, the green 

check means that Objects is the current layer. 

 Name: The name of the layer. Give layers understandable names. 

 On: If a layer is 'On' it means that it is visible (but objects can still be erased 

when the 'Select > All option is used). 

 Freeze: A layer is not visible and cannot be deleted. 

 Lock: Layer is visible, but cannot be modified. 

 Color: A specific color for everything on that layer. 

 Line type: A specific line type (hidden, center, etc) for the layer. 
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 Line weight: The visible width of the objects on that layer. 

 Plot: A defined color for the plotter to use on that layer. 

 Plot (yes, two columns use the same name: Switch on or off if that layer is 

plotted. 
 Description: A user-defined description for the layer.  

ADDING TEXT  

TEXT is your current drawing layer now, so what you will be doing is creating some 
text now. Type in TEXT on the command line. Look at the command line. 

Command: text 
Justify/Style/<Start point>:  

The first thing AutoCAD wants is a starting point for the text. Type: 0, 0 to place it 

at the bottom left corner of your drawing. Notice that there are other options you 
could make, but ignore them for now. 

Height <0.2000>:  

Next, AutoCAD wants to know how tall you want your letters to be. For this 
assignment, you want them to be 1/4" tall. Type in .25 at the Height prompt. 

Rotation angle <0>: 

One more thing before you start typing in text, tell AutoCAD if you want to have your 
text rotated. Not this time, so press <ENTER> to accept the default of 0 degrees. 

Text: (YOU’RE NAME - ASSIGNMENT #6) 

Finally you can type in what you want to put on the drawing. At the prompt, type 

your NAME and ASSIGNMENT #6 then press <ENTER>.  

You will see that AutoCAD has placed your name in the bottom left corner at 1/4" 
high and in yellow on the 'Text' layer. 

You don't really want your name jammed into the corner like that so move it up and 
over 1/8" (Remember your MOVE command and relative points : @.125,.125) 

Now it's time to start dimensioning your drawing. Bring up the Layer dialog box and 
make DIM your current layer.  

This is one time when I recommend using the icons. Dimensioning is A LOT easier 

this way. If you don't see your dimensioning toolbar on the screen, right click on one 

of your toolbar icons and check the Dimension checkbox. You'll see the toolbar 
appear. Close the Toolbars dialog box. 

There are several different types of dimensions, here are the ones you'll be using in 

this lesson (Each of the dimensioning icons gives you a quick clue as to which type of 

dimension it will create.) The image below shows you the standard dimensioning 
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icons. This list below shows you which dimension types you will use in this lesson 
(Place your mouse on the toolbar icons to see what they represent. 

 

 
Here are the ones you'll be using in this lesson.  

Linear dimensions are used for dimensioning either horizontal or vertical distances.  

Aligned dimensions will measure the actual length of an angled line. 

Radius dimensions will give you the radius of either arcs or circles. 

Diameter dimensions are used on circles. 

Angular dimensions will measure the angle between two lines that you pick. 

Baseline dimensions are a special type that will automatically stack dimensions 
along one plane as you pick points. 

The type of dimension you pick will depend entirely upon what information you want 

to convey to the person reading the drawing. Look at the sample drawing and pick 
out the different types of dimensions and where they are used. 

We'll start with the most common (and easiest): Linear Dimensions. You'll use this 

type to add dimensions to the rectangle in the bottom left of your drawing. Pick on 
the icon and then look at the command line. 

Command: _dim linear 

Specify first extension line origin or <select object>: 

It asks for either the origin of the first dimension line (a starting point) or you can 

press <ENTER> to select a particular line. Turn your OSNAPS on to endpoint only. 

Pick the top left corner of the rectangle. AutoCAD then asks for the second extension 

line origin. Pick the top right corner. You'll then see the dimension appear and 

AutoCAD asks for the Dimension line location. Pick somewhere just above the line 
where you think it fits well. 

AutoCAD then shows you the length that it found to be the length of the line you just 

dimensioned. The following lines show what you should have seen on your command 

line:  

 

Specify second extension line origin: <SELECT TOP RIGHT CORNER> 

Specify dimension line location or  

[Text/Text/Angle/Horizontal/Vertical/Rotated]: <PICK ABOVE THE LINE> 
Dimension text = 3.000 

Now dimension the line on the left side using the same method. 
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Now you want to dimension the radius of the fillet on the object above the first box. 

Pick the icon for radius dimension. AutoCAD asks you to select an arc or circle. 

Pick the arc on the top left corner. Again AutoCAD then wants you to pick the 
dimension line location. Pick anywhere outside the arc where the dimension fits well. 

Looking at the top left object on the sample sheet, notice that there are a few ways 

to dimension the corners. Start on the bottom left. Pick the Linear Dimension icon. 

Instead of picking the two endpoints, press <ENTER> and AutoCAD will ask you to 

select the object you want to dimension. Pick on the angled line in the bottom left 

corner. As you move your cursor around, you'll see that you could place it either to 

the left or below the line. Choose one or the other and place your dimension. Repeat 
these steps to add the other dimension. 

At the top left, you want to add an Aligned dimension. Pick the icon for this. As 

with the linear dimensions, you can either pick the endpoints or press <ENTER> to 

choose and object. When you're asked to place the dimension, you'll see that you 

can only move parallel to the line that you picked. Place the dimension line 
somewhere outside the object. 

Now you're going to dimension the angle on the bottom right corner of the top box. 

Pick the Angular dimension icon. Pick the bottom line and then the angled line in 

the bottom right corner. Place the dimension so that it looks like the one in the 
sample. 

Now its time to dimension the circle. Pick the icon for the Diameter dimension. 

AutoCAD then wants you to select the arc or circle. Pick anywhere on the circle. Then 

you have to place the dimension line somewhere. Pick a good spot for it. 

Dimension the 1" line in the circle as shown using a linear dimension. 

Dimension the top left box of the array as shown using Linear dimensions. 

Dimension the space (0.75) between the two rows by picking the endpoints of the 
lines. 

Dimension the space (0.75) between the columns as shown. 

Now for the tricky part. You want to add baseline dimensions to the column distance 

dimension you just created. Pick the icon for the baseline dimensions. Look at the 
command line: 

You may be asked to select the base dimension. If so, pick on the 0.75 dimension for 

the column. Then you're asked to specify a second extension line origin. Pick 

where P1 shows you on the sample drawing. AutoCAD then will get you to keep 

repeating this process until you press <ENTER> to end the command. Pick near P2 

to continue, then press <ENTER>. This is what your command line should have 

looked like: 

Command: _dim baseline 

Select base dimension:  

Specify a second extension line origin or (Undo/<Select>) :< pick P1> 
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Dimension text = 1.50 

Specify a second extension line origin or (Undo/<Select>) : <pick P2> 

Dimension text = 2.00 
Specify a second extension line origin or (Undo/<Select>) : <ENTER> 

Your drawing should now look similar to the sample drawing. Check to see if you 
missed any dimensions.  

Now you have dimensioned the drawing, save it and print it. 

Next you want to copy everything over 12" to the right. Start the COPY command, 

and when asked to select objects, type ALL <ENTER>. Then copy it all 12" to the 
right. 

What you want to do next is scale the copy of everything to double its existing size. 

Start the SCALE command. When asked to select objects, draw a window around the 

new set of objects and press <ENTER>. When asked for a base point, pick the 

bottom left corner of the border. Enter 2 for the scale factor. Your command line 

should look like this: 

Command: sc 

SCALE 

Select objects: Other corner: 38 found 

Select objects :< ENTER> 

Base point :< PICK THE BOTTOM LEFT CORNER)  
<Scale factor>/Reference: 2 <ENTER> 

Perform a Zoom Extents (type Z <ENTER> E <ENTER>) at the command line. Now 

that everything is twice as large, zoom in on your dimensions and you'll see that 

they have automatically adjusted to the new sizes! This is called associative 

dimensioning.  

There are many different parameters you can change to get just the right look for 

your dimensions and text (use the DDIM command). This is will not be covered in 
this course. 

For practice, you can try dimensioning some of your other assignments. 

Even if your drawing is 100% accurate, it is still only as good as the dimensions. 
Some common mistakes when dimensioning are: 

 Not using your Osnaps. If you don't get the exact endpoint of a line, then 

your dimension is wrong. 

 Snapping to the wrong point. In detailed drawings, this can be easy to do if 

you aren't paying attention. 

 Incomplete dimensions. If you miss one or two dimensions, you can delay the 

project while these numbers are located, new drawings made, delivered, 

etc... 
 Confusing dimensions. Make sure that your dimensions don't overlap, or aren't too close, or 

otherwise unclear. 

http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm#print
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Direct Distance Entry 

As mentioned earlier in the lessons, there are many ways to do things in AutoCAD. 

To enter distances, you have been shown Absolute, Relative and Polar Co-ordinates. 

Now you will be shown two more ways to tell AutoCAD where the locate the point 
you are drawing to. 

DO NOT FORGET THE BASICS OF MANUAL ENTRY 

Direct Distance Entry (or DDE) is a way of bypassing the usual ways of entering in 
co-ordinates and just entering the distance. 

The method is quite easy. 

Make sure that you have set Ortho (locking your input to vertical and horizontal) by 

pressing the F8 button and checking to see that the "Ortho" button is depressed on 

the status bar like this: Your F8 key will toggle Ortho on and off.  

Let’s say you want to draw a line from one point directly to the right 10 units. 

Start the Line command and click on the screen anywhere, then more your cursor to 

the right of that point. If Ortho is turned on, the line should only point directly to the 

right and not at an angle. Now type in 10 <ENTER>. Press <ENTER> again to exit 
the command. You now have line that is 10 units long. 

 

That is a very easy way to draw line segments. If Ortho is not set, your drawing will 

get messed up very quickly and will not be easy to fix. I have seen too many 
students take this easy route and wreck projects. 

Now wouldn't it be cool to draw angled lines (like the short ones in the above 
image)? Well you can, but first you have to make change in your settings. 

Type in DSETTINGS and you get the Drafting Settings dialog box, go to the "Polar 
Tracking" tab.: 
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Then make sure that Polar Tracking is on (press your F10 key to toggle it on and off) 

and then select the increment angle.  

Polar Tracking  

In the example above, I made 4 lines 1 unit long using Direct Distance Entry (DDE). 

See if you can duplicate this on the end of the 10 unit line you just drew. The 

process is the same as you did for the DDE of the previous line. Make sure your 

increment angle is 30° and draw a line 4 units longs using DDE...  

 

You can not have Ortho and Polar Tracking on at the same time. As you start to draw 

more, you will see that these two features are great time savers. There will be times, 

though, when you have to use absolute and relative co-ordinate entry (especially in 
3D). 

Refer back to the assignment in Lesson 1-2 and draw using the methods shown in 

this lesson.  

Now I'm going to repeat this one last time:  

Make sure you have either Ortho or Polar tracking on and don't forget how 

to manually enter points!  

Object Snap Tracking  

Now you've just seen how you can find distances from points and measure 

accurately, but what if you want to find specific points based on previously drawn 

objects? You can use Osnaps, but they don't always find the point you need. 

http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm
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Consider that you want to draw a circle in the middle of a rectangle like the example 
below: 

 

In the olden days, you would have drawn a line from the corners of the rectangle to 

find the middle, then snapped to the midpoint of that line for the circle's center 

point, drawn the circle and then erased the reference line. 

Now you can use object snap tracking. This is a way of finding reference points 

and drawing from them. To do this exercise, make sure that your Midpoint Osnap is 
on.  

Draw a RECTANGLE from 0, 0 to 4, and 3 

Make sure that the Object Snap Tracking and Osnap button are depressed on 

the status bar. 

Start the CIRCLE command. 

Move your cursor over the middle of the bottom line of the rectangle. You should see 

a light dotted line project vertically through your cursor. Now more your cursor to 

the middle of the right vertical line of the rectangle. As you move your cursor 

towards the center of the rectangle, you should see the 2 dotted lines cross. It 

should look like this: 

 

Once you see both lines, you can pick and the center point will be exact center of the 
rectangle. Give your circle a radius of 1". 

This is a very simple example, but as you start drawing more complex shapes, this 

will be a handy to tool to master. Object tracking will work with any Osnap that is 
invoked. But always check to make sure that you are picking the point you want. 

To review, AutoCAD provides some nice tools to enhance your productivity. Use 

them, master them, but don't forget the basic of inputting points. Especially when 
you do 3D work, manual entry becomes valuable.  
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Object Properties 

Now that you have learned how to draw objects and modify those using special 

commands, you need to know one more way changing the properties of an object. 

For instance, you may have made a spelling mistake in your text. You could erase it 

and re-create it, or you could double-click on it and just correct the error. This 
process is an extremely important tool to help you with your CAD work.  

DON'T REDRAW AN OBJECT - CHANGE ITS PROPERTIES 

There are a few ways to change, or view an objects properties. First is by using the 
PROPERTIES command.  

Command Keystroke Icon Menu Result 

Properties PROPERTIES 
 

Modify > 

Properties  

Displays the properties 

of the object in the 

Properties Palette 

The method is quite easy and also the most complete way of viewing properties.  

Draw a line from (any point) to (any point) and press (ENTER). This is only time I 
will not tell you to use specific co-ordinates. :) 

Now select the object by clicking on it and pick the properties icon. Once you do this, 

you should see the properties palette appear showing everything that makes that 
line what it is. 
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What you see here is the complete palette. Before you look at the properties, take a 

moment to examine the palette itself. These are new to later versions of AutoCAD. 

Since it takes up a large amount of the screen, you have the option to either close it 

completely ('X' at the top) or collapse or hide the palette (arrows at bottom) for 
future reference.  

Now look at the properties as displayed in the palette. You will see that one endpoint 

of the line is shown as the "Start X" and "Start Y" points (X, Y point). If you want to 

change the location of the X co-ordinate for the Start point, pick in the text area, 

type a number and press (ENTER). You also have the option of picking new X co-
ordinate with the small icon shown above. 

Have good look at the palette. Erase the first line, draw another line and then 
display the new line's properties. You should see different numbers. 

Now erase the line and draw a circle. Display the properties and you will see 

different fields. You will see that the the Start X point has been changed to "Center 
X". The properties displayed are specific to the object you have selected. 

Now draw a line next to the circle. Select both by clicking on one, and then the 

other. Now display the properties by selecting the icon. You will now see a much 

short list of properties. This short list will include properties that are common to both 

objects, such as layer, color, etc.  

Now try something different. Erase everything and close the Properties palette. Draw 

a circle and then select it. Right click on the screen and choose the Properties option 
at the bottom of the list as shown below: 

 

You'll see the same palette appear - in the same space where you closed it. 
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OTHER OBJECTS  

By now you see how you can view and edit properties of objects you have drawn. 

Those the methods will work on any object. But what about other objects? Could 
there be easier ways to edit their properties? You bet! 

Enter a line of text like you did in the Lesson 1-8. View the properties like you did in 

the previous examples. Note again, the various fields. Now try "Double-Clicking" on 
the text. 

 

Now you can change the text and press <ENTER> (then <ENTER> to end the 

command). This is a much easier method to change the text's content, but none of 

the other properties. You could also have changed the text in the Properties palette, 
but this method is much quicker. 

Changing Layers 

Many times you will draw an object and find that is on the wrong layer. To change an 

object's layer, you can open the Properties palette (as shown above) or use this easy 
tip. 

Create a new LAYER (as you did in Lesson 1-8) and call it LINES. Do not make it the 
current layer. Draw a line on the 0 layer. 

Now select the object and then move your cursor up to the layer droplist. You'll see a 
list of all of your layers - pick on the LINES layer - then press ESC. 

 

Now when you check the properties of the line, you'll see that it is on the LINES 
layer. This is one method you will be using a lot, so learn it and master it.  

Conclusion 

You now have the skills to change to properties of any object you draw. There are 

many ways of doing it, but you'll see that some methods are easier. So remember, 

once something is drawn, you can modify it as shown in the previous lessons in this 

level, or modify the properties. In only rare instances, is it easier to erase and 

redraw the object? As you learn more commands in the next lessons, try these 
methods to see what can be changed - and how. 

There are other ways that will be shown in future lessons in the next levels.  

http://www.we-r-here.com/cad/tutorials/level_1/1-8.htm#text
http://www.we-r-here.com/cad/tutorials/level_1/1-8.htm#layer
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Planning a Project 

This lesson will have you using the tools you learned in the first level. Believe it or 

not, if you understand the commands taught in the first level, you understand almost 

all of the common commands used in AutoCAD - for any version.  

For this lesson, you will be drawing a floor plan of an office layout. There are two 

different plans to choose between. Choose the one that you feel most comfortable 
with. Click on the icons below to view the projects. 

PROJECT > GIF IMAGE AUTOCAD DWG FILE 

Option # 1 - Computer 

Room   

Option # 2 - Office Space 
  

Option # 3 - Office Metric 
  

You can complete all 3 if you like, and Option #1 is the simplest project if you want 

to start off easy.  

The first thing you want to do is set up your drawing. There are a few basic steps to 
approaching EVERY drawing you do in CAD. 

1. Make sure you have the ability to draw it. See if there is anything in the 

drawing that you would not be able to reproduce. You should also see if you 

have all the information you need to complete the drawing. One missing 

dimension can make the entire drawing very difficult. 

2. See what units are used. Is it Architectural, Decimal, Standard, Metric? This 

will need to be known so you can set the drawing units. 

3. What area is needed? Again, you may want to set up the initial drawing area 

(or limits). 

4. What layers will you need to start with? Remember that you can always add 

more, or delete the ones you don't need. 

5. Once you have this basic information, you can begin. As you can see, there is 

a bit you have to do before drawing your first line. Get into the good habit of 

beginning your drawings properly and not with the attitude that you can 
always "Fix it later!" 

If you have a prototype (or template) drawing already set up, use it. If you feel that 

you will be doing this type of drawing often, make a template drawing once you have 

set up all the parameters you need. Do this by saving the file with a DWT extension. 

This is AutoCAD's standard for template files. 

AutoCAD also has a large number of templates to get you started. You can find these 
through the New Drawing dialog box. 

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm
http://www.we-r-here.com/cad/tutorials/level_2/links/computer_room.gif
http://www.we-r-here.com/cad/tutorials/level_2/links/comproom.dwg
http://www.we-r-here.com/cad/tutorials/level_2/links/office_space.gif
http://www.we-r-here.com/cad/tutorials/level_2/links/office.dwg
http://www.we-r-here.com/cad/tutorials/level_2/links/office_space_metric.gif
http://www.we-r-here.com/cad/tutorials/level_2/links/office_metric.dwg
http://www.we-r-here.com/cad/tutorials/level_4/4-1.htm
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Once your drawing is set up, think about how you will actually draw it. You should 

start with the most basic components first. Remember that it is just like building a 

structure. Start with the foundation and add more detail as you go. Look at the outer 

walls and start there. Next draw the inside walls. Then add more details such as the 

door openings, doors, windows, etc. Finish up with the furnishings. Be careful with 

your measurements, because if you make a mistake at the start, it will cause BIG 

problems later on as you continue through the drawing. 

A general rule I use is to draw like I would build it. This basic approach will at least 
give you a starting point for any project in any discipline. 

The first two projects are designed using imperial, architectural units (i.e.: 3'-6") as 
opposed to metric units.  

Just like in Previous Lessons, start AutoCAD and a new drawing by using the menu 

option File > New. You will see a dialog box open that asks you to select a template 

drawing to use (as shown below): 

 

To set up a template drawing, use the procedure you did in Level 1, except that you 

will set all the parameters that you will need for your drawings. These would include: 

layers, text styles, dimensions styles, units, area and possibly a title block layout. 

Once this is done, you are ready to begin drawing.  

For Imperial Drawings (Computer Room and Office): 

 

Start a new drawing and use the acad.dwt template.  

 

Set the units by typing in UNITS and setting the "Length Type" to Architectural. 

 

Next set your dimension scale by typing in DIMSCALE and entering 48 at the 

prompt (More on this in a later lesson). This enlarges the dimensions to match size 

of your drawing.  

Now you want to set your dimension text to read in Architectural units. To do this, 

type in DDIM and press the Modify... button. Then pick on the Primary Units tab. 
Your dialog box should look like this at this point: 

http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm#start
http://www.we-r-here.com/cad/tutorials/level_4/4-11.htm
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Change the Unit Format to "Architectural", press OK and then close the dialog box to 

return to your drawing area.  

Next create the layers you think you will need. Take time to give them 

understandable names, unique colors, etc.  

If you want, you can now save this as a template drawing (details in this lesson)...  

Setup for drawing the Office Metric Project: 

This will similar to the steps above, with these changes. 

Open a new drawing and use the cadi’s template (as shown in the dialog box 
above). 

You don't need to change the units, but change the DIMSCALE to 10. 

Where to start:  

You're ready to start drawing now. As mentioned above, start with the outside and 

work your way in. If you are drawing the first project, you can easily draw the 

outside walls (using DDE), then offset them by the thickness of the wall. From there, 

it's just a matter of inserting the door openings. I usually do that by offsetting lines, 

then trimming away what I don't need. For the doors themselves, just draw a 

rectangle and rotate it. For drawing the desks, remember the array command. So 

with just a few commands, you can draw this room - all the commands you learned 

in Level 1 Of course, there are many ways to draw the same project.  

When you are drawing these projects, you may want to move around the drawing 

and go to closer views. Feel free to jump ahead to the next lesson on Zooming and 
Panning when you need to.  

Once you have drawn the basic plan, dimension it (refer to Level 1-8 lessons). From 

the "Computer Room" plan you will be adding computers and other accessories to 

the desks later in the course, so save the file when you are done... 

http://www.we-r-here.com/cad/tutorials/level_1/1-8.htm#layer
http://www.we-r-here.com/cad/tutorials/level_4/4-1.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-9.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-7.htm
http://www.we-r-here.com/cad/tutorials/level_2/2-2.htm
http://www.we-r-here.com/cad/tutorials/level_2/2-2.htm
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Zooming and Panning 

So far the lessons in this class have dealt with setting up the drawing. This lesson 

will be a primer on how to move around in your drawing. With simple drawings like 

the assignments in Level 1, you didn't have much need for moving around or 

zooming in your drawing. The more complex you’re drawing is, the more you will 

need to master the power of zooming and panning. Mastering these techniques will 

enable you to be more productive in your drawings and life will be better.  

EFFECTIVE ZOOMING CAN DRAMATICALLY INCREASE YOUR SPEED 

One single command will give you the versatility to move around your drawing. This 

is the ZOOM command. Another useful command is PANNING. These are both 

quicker than using the scroll bars on the side of the drawing area, unless you have a 
very short distance to move your drawing. 

Start the Zoom command by typing Z <ENTER>. When you do this, you will see the 

following options on the command line: 

Command: z <ENTER> ZOOM 

Specify corner of window, enter a scale factor (nix or nap), or  

[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real 
time>: 

Remember that to invoke any option, just type the capital letter of your choice. 

(Egg: type: E <ENTER> for "zoom extents". The default is "Real-time" which you 
invoke by pressing <ENTER>. One by one, here are the options available to you. 

COMMAND 

OPTION 
ICON DESCRIPTION 

Zoom All 
 

This option causes AutoCAD to display the whole drawing as 

far as its drawing limits or drawing extents (whichever is the 

greater of the two). 

Zoom 

Center   

This option requires two things: a point that is to be the 

center of the new display and a value to be its new height in 

drawing units. The existing height is the default for the new 

height to allow for panning across the drawing. If the new 

height value is followed by "X" (egg. 2x), then it is taken as a 

magnification factor relative to the current height. If followed 

by "XP", then it is taken as a scale factor relative to paper 

space and can be used for scaling the contents of paper 

space view ports. 

Zoom 

Dynamic  
 

This is a very useful ZOOM option once it is understood. It 

permits very quick movement around the drawing. Once 

selected, this option redraws the graphics area of the screen 

and displays two rectangles. The larger box shows the 

extents of the current drawing. The smaller box shows the 

current view with an "X" in the middle. This moves with the 

mouse. This view box should be positioned so that its lower 
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left corner is at the lower left corner of the view required. By 

pressing the left button on the mouse, the "X" is replaced by 

an "> " pointing to the right side of the view box. This allows 

you to change the magnification. As the mouse is moved, the 

view box shrinks and expands so that the size of the required 

view can be set. The left mouse button toggles between PAN 

"X" and ZOOM "> " mode so that fine adjustments can be 

achieved. When the view required has been selected, press 

<ENTER> or right click to cause AutoCAD to display it. 

Zoom 

Extents  

This option will display all the graphics that are contained in 

the drawing (referred to as the drawing extents) with the 

largest image possible. 

Zoom 

Previous  

This option restores the displayed view prior to the current 

one. For the purpose of this option, up to 10 views are saved 

so that the last ten views can be recalled. This option includes 

every time you use the scroll bar, which is one reason to 

avoid the scroll bars for panning a lot in your drawing. 

Zoom 

Scale  

This is a 'hidden' default option. You do not have to type "S" 

to choose this option. It simply requires the entry of a number 

that represents a magnification factor. Note that the factor is 

applied to the entire drawing (as defined by the drawing's 

limits). Numbers less than 1 will reduce the displayed size of 

the drawing, while numbers greater than 1 will enlarge it. If 

"X" is inserted after the number (eg. 0.8x) then the factor is 

applied to the current view. If "XP" is inserted after the scale 

factor, then the view is scaled relative to paper space. This is 

useful for zooming a view within a paper space view port to a 

specific scale, for example, "1/48XP" will produce a view of 

model space at a scale of ¼" = 1' relative to paper space. 

Zoom 

Window  

This option (also a 'hidden' default) prompts the user to pick 

two corners of a box on the existing view in order to enlarge 

that area to fill the display. 

Zoom  

Real-time  

Zoom Real-time provides interactive zooming capability. 

Pressing <ENTER> (after entering zoom) on the command 

line automatically places you in Real-time mode. Hold the left 

mouse button down at the midpoint of the drawing and move 

the cursor vertically to the top (positive direction) of the 

window to zoom in up to 100% (2x magnification). Hold the 

left mouse button down at the midpoint of the drawing and 

move the cursor vertically to the bottom (negative direction) 

of the window to zoom out to100% (.5x magnification). You 
cannot zoom out beyond the extents of the current view. 

When you release the pick button, zooming stops. You can 

release the pick button, move the cursor to another location 

in the drawing, and then press the pick button again and 

continue zooming from that location. To exit Real-time Zoom 

mode, press <ENTER> or (ESC). 
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Aerial View 

command: 

DSVIEWER 

None 

Aerial View is a zooming tool that displays a view of the 

drawing in a separate window so that you can quickly move to 

that area. If you keep the Aerial View window open as you 

work, you can zoom and pan without choosing a menu option 

or entering a command. You can change the view by creating 

a new view box in the Aerial View window. To zoom in to the 

drawing, make the view box smaller by left clicking a 

rectangle. To zoom out of the drawing, make the view box 

larger. As you zoom in or out of the drawing, a real-time view 

of the current zoom location is displayed in the graphics area. 

The screenshot shows how the view box looks. Right click in 

the box and you can move the box to where you want to zoom 

to. 

Zoom 

Object  

This option asks you to select an object or objects, then press 

<ENTER> and the screen will zoom to those objects only. This 

is great for when you want to work on object.  

Zoom In  
 

Clicking this icon will zoom in to the drawing by about 50%. 

This option is only available as an icon and cannot be invoked 

by the command line.  

Zoom Out 
 

Similar to 'Zoom In' - this icon will zoom out of your drawing 

and allow you to see about 50% more of your drawing space.  

Mouse 

Scroll  
- 

If you have a scrolling wheel on your mouse, you can use it to 

zoom in and out of your drawing. Scroll towards you to zoom 

out and away from you to zoom in. You have the option to 

change the amount of zoom per wheel click with the Zoom 

factor system variable. Keep in mind that you will zoom in and 

out using your mouse location as a 'centre point'.  

PAN  
 

Panning allows you to quickly move around the drawing area 

at the same magnification you currently have set. Type in 

PAN (or P) <ENTER> and a hand will appear on the screen. 

Left click and hold to move around your drawing. 

As you can see there are quite a few options. To begin with I would strongly 

recommend getting really good at these 3: 

Use the Zoom > Extents whenever you want to see all objects.  

Use the Zoom > Window option to 'close-in' on one area.  
Use the Zoom > Previous option to return to where you were. 

I generally use them in conjunction with each other. I'll do a zoom extents to see 

what state the drawing is at, then perform a Zoom Window to get to the area I need 

to work in, then do a Zoom Extents when I am done in that area. In between, I may 
need to use a combination of Zoom Window and Zoom Previous.  

The zoom command can also be invoked transparently. This means that you can 

start it up in the middle of a command. For example, if you are in the trim command 

and want to see a bit more of your drawing, just type 'Z (note the apostrophe) at the 
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command line and you can then zoom using any of the available options. Press 
<ENTER> to get back to your command.  

Also, right clicking while in the zoom command gives you options. Try this and see 
which choices are available with this. 

Exercise: Open one of your previous drawings, or one of the samples that came 

with your installation of AutoCAD and practice these techniques. You need to be good 
at this.  
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Formatting Text 

To format text in AutoCAD, you have to create a new text style for each different 
font and style of text. 

By default in the acad.dwt file, AutoCAD loads the txt font because it is simple to 

display on the screen. Unfortunately, it is a very basic and 'ugly' font. Here is an 

example of the default TXT font compared to the 'standard' ROMANS font. Look at 
the O's in particular. The TXT font has no curves.  

 

It is easy to load in a new style for all of your text. Here's how: 

Use your pull-down menus Format > Text, or type ST, and this dialog box appears. 

 

 

 

Click on the Font Name edit box and select "romans.shx" as your new text style. 

This style will be used for all text and dimensioning in the next assignments. This is a 
common, clean font that AutoCAD can display quickly on the screen. 

No other adjustments are needed. IMPORTANT: Do NOT change the Height in this 

dialog box unless you really know why you are doing it. If you set a height here, 

AutoCAD will not be able to scale if for uses such as dimensioning, in other words, it 
is fixed.  

Creating New Textsyles  

Once you get into more complex drawings, you will need more than one textstyle. 

One for notes, one for tables, one for the table header, two or three for the title 
block - I think you get the picture. 

If you need more than one text style, click on the new button, type in a new name 

and press OK.  
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Now the Text Style dialog box (as shown above) will have the new name in the Style 
Name field. Select RomanD.shx for this new style. 

Now when you add text to your drawing, you have 2 choices. Watch the command 
line to know when to change to another style. 

Command: text <ENTER>  

Current text style: "Standard" Text height: 3.5090 

Specify start point of text or [Justify/Style]: S <ENTER> 

Enter style name or [?] <Standard>: BOLD <ENTER> 

Current text style: "BOLD" Text height: 3.5090 

Specify start point of text or [Justify/Style] : <PICK A POINT>  

Specify height <3.5090>: 1 <ENTER> 

Specify rotation angle of text <0> : <ENTER> 

Enter text: ROMAN "D" <ENTER> 
Enter text: <ENTER> 

Of course, there a few ways of entering text in AutoCAD, but this will give you the 

basic idea. Once you have used the two different styles, it should look something like 
this: 

 

In this versions of AutoCAD, there is an easy way to change existing text to a new 

style. First, select the text, then go up to the Text Style Menu (usually towards the 

top of the screen) and select the style you want from the droplist (below) and the 

text will change automatically. 

 

Professional looking and clear text is essential in any CAD drawing. Practice with 
different styles until you are comfortable with these concepts. 
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NOTE: AutoCAD uses two types of fonts: true-type and 'SHX' vector fonts. True-type 

fonts are indicated by a small symbol beside the font name. As a rule, you will 

want to use the SHX fonts, as AutoCAD can draw these faster. Newer releases of 

AutoCAD handle true-type faster than before, but they can still slow down your 

display speed. Another concern when using True-type fonts is that if you are 

exchanging drawing files with other people, they may not have the same fonts 

installed on their system. This could lead to formatting problems when they open 
your files. 
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Layout Tabs - Paper space & Model space 

In Level 1 you printed out your project using 'model space'. This lesson will show you 

the preferred way of plotting your drawings. In AutoCAD there are two different 

workspaces: model space and Layout / Paper Space. For now think of model space 

where you make your model, or draw. Think of the Layout Tabs as where you print 

your drawing from, or layout the final drawing complete with dimensions, notes, title 

block, etc. Look at the images below to see a visual explanation of the concept. 

Note about the terminology in this Lesson: 

After AutoCAD R14, the term "Paper Space" was replaced by "Layout". These terms 

are interchangeable. The release of AutoCAD 2000 brought other enhancements to 

this functionality. You can now have multiple layouts, you can name them, and you 
can re-sequence them and more. 

What is a Layout? 

A layout is a page that allows you to set up a plot or printout of your drawing. Below 
is a sample of what a layout looks like (a really simple one).  

 

The floor plan and dimensions (above) were created in MODEL SPACE at a 1:1 scale. 

The walls were drawn to be 30' or more long. 

The title block and view port were created in a LAYOUT TAB / PAPER SPACE at a 1:1 
scale. The title block is 8-1/2 x 11 inches. 

The view port is a window into "model space". In the image below, the the view port 

is the black rectangle and the contents of the view port are displayed inside it. The 

contents of the view port are scaled to either fit the view port or (preferably) to 

conform to a specific drafting scale (i.e.: 1"=1')  

Below is an example of a layout for a print to be plotted from a Layout tab.  

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm
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This conceptual image shows the relationship between model space and a Layout. 

Think of paper space as being 'above' model space. To see through 'into' model 

space, you have to create a view port (Make View port MV command). Think of a 
view port as a window. 

As soon as you create the view port, the window is closed and the extents of your 

drawing are displayed. You can see through it, but you can not 'touch' anything in 
model space. 

To have access to your objects in model space from paper space, you have to enter 

the view port by typing MS <ENTER>. This 'opens the window' for access. Type in 

PS <ENTER> to 'close the window'.  

You may be wondering why you shouldn't just plot from model space. You can and 

many people do, but the advantage of plotting from paper space is that you can 

have many layouts from one drawing. You can even add detail views without having 

to copy and scale your geometry. This feature has been radically changed in 

AutoCAD 2000 and is much more versatile. You now have multiple tabs to organize 

your plots (or 'sheets'). As a rule, unless you're working for a behind-the-times 
company, use Layouts. 

To toggle between the two spaces, you can pick on one of the layout tabs and back 

to the Model tab. You can also enter the command TILEMODE and set it to 0 for 

paper space and 1 for model space. When you do this, you will notice that the UCS 

icon in the bottom left corner changed to a triangular icon. This new icon confirms 
that you are paper space. 

Model Space (UCS) >> 
 

Layout Tab (Paper Space) 

>> 
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When you are in paper space you can draw or insert a title block. In paper space you 

are still drawing at a 1:1 scale. 

Start this exercise by drawing a simple title block (sample) in the tab called Layout 
1. Make sure you draw it at 1:1 scale.  

Once your title block is drawn, you can create a floating view port . This is a 

'window' into your model space. To create a view port, type in MV (for Make View 

port) and then pick two points just as if you are drawing a rectangle. Use as much of 
your title block as possible. 

As soon as your view port is created, you will see all that you have drawn in model 

space appear to its extents. The next thing you need to do is to scale your view port 
for accurate plotting. 

To do this, you have to 'enter' your view port. Do this by either typing MS (for model 

space) or clicking on the square labeled PAPER (it will switch to Model) on the status 

bar. In newer versions of AutoCAD like 2005 you can also double-click in the view 

port. You will notice that the familiar WCS icon appears in the bottom left corner of 

the view port. If you have more than one view port on the screen, left-click in the 

one that you want to scale or type CTRL+R to toggle through them to the one you 
want. To scale a view port, you just use the ZOOM command. Type in Z <ENTER> 

At the command prompt, you must tell AutoCAD what scale you want the view port 
to be. This coincides with the scale that you will plot at.  

PLOT SCALE ENTER: 

¼" = 1' 1/48XP 

¾" = 1' 3/48XP 

½" = 1' 1/24XP 

The table above gives you some sample scales. Take ¼" = 1' for example. First 

remember that 1'=12". If you cross-multiply the 12 by the 4, you get 48. Therefore 

this scale will be at a 1:48 scale (ratio), or in other terms, your model will be 1/48th 

the size of real life on paper. To get AutoCAD to scale the view port, you must type 

in Z <ENTER> 1/48XP <ENTER>. This means 1/48th times (X) in relation to paper 
space (P). 

Figuring out what scale you require takes some calculation. You can see what your 

extents in model space are and then see what your view port size is. You can also 

use trial and error to see what fits in your view port. This can sometimes be quicker 

than calculating. 

To sum this up, here are the basic steps required for using paper space layouts:  

1. Finish your drawing (with dimensions) in model space.  

2. Change to paper space. TILEMODE to 0 or click on the Layout tab  

3. Add a title block.  

4. Create a view port using the MVIEW (MV) command.  

http://www.we-r-here.com/cad/tutorials/level_2/images/title_block.gif
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5. Enter your view port by typing MS (or double-click in the view port)  

6. Zoom in using a specific ratio by typing in Z <ENTER> ___/___XP <ENTER>  

7. Leave your view port by typing PS and return to paper space.  

One thing that is very important to remember is that you should use paper space 

only for plotting. Do not modify your model in paper space. Return to true model 

space for any editing that you need to do. Also, do not draw objects on the Layout 
screen that is part of the drawing.  

To practice this concept, open up one of the drawings you did in Lesson 2-1.  

Change to paper space. Draw or insert a title block. If you do not have one, you 

can find a good 11x17 (B size) title block in your AutoCAD support folder (filename: 

ANSI_B.DWG). Insert this and then create a view port. Enter your view port and 

scale as explained above. Return to paper space and print using the settings, 
EXTENTS / SCALE: 1=1. 

10 View port Tips: 

1. You can create new layout tabs by right-clicking on an existing tabs and 

choosing New Layout.  

2. You can rename a tab by right-clicking and choosing rename.  

3. You can create view ports of various shapes by creating the object and then 

using the MV command with the Object option.  

4. You can also choose to dimension in the Layout. This can be very convenient 

in AutoCAD 2005. Your dim scale is 1 and all your dimensions are consistent. 

Try this out on a sample drawing. AutoCAD will scale the dimension to size of 

the object in the view port.  

5. You can resize view ports with regular modifying commands and grips.  

6. Put view ports on the layer called DEFPOINTS (created by dimensions) and 

they won't plot or put them on a separate layer with the plot option turned 

off.  

7. To quickly find the zoom factor of your view port, use the LIST command on 

it.  

8. You can lock and unlock view ports by using the MV > L option.  

9. You can freeze (turn off) layers in any view port. (See below)  

10. You can now have your view ports plot for 3D drawings as wire frame, hidden 
line and rendered views when you plot - this is great! (See below)  
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To turn layers off in a view port, you need to be on a Layout Tab and in Model Space 

of a view port. In the view port, then move your cursor to the layer droplist and 

select the layer you want off and hit the "Freeze in View port" icon for that layer, 
then click on the drawing area. 

 

 
To reverse this, use the same process which will "Thaw" the layer in that view port. 

The ability to use view ports successfully leads to well organized drawings and print 

sets. From there, you can put together sheet sets for distributing to other people. 

When it comes to plotting 3D drawings, Layouts are essential to capture the views 

you need and put them on paper. It may take some time to master the concept and 
procedures, but the results will be well worth it.  
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BLOCKS 

In this lesson you will be introduced to blocks. By definition, a BLOCK is a collection 

of simple entities (lines, arcs, circles, text, etc.) that form a more complex entity 

that normally represents an object in the real world, e.g. a door, a chair, a window, a 
computer.  

There are many advantages to using blocks, here the major ones: 

 Blocks are a single entity. This means that you can modify (move, copy, 
rotate) a block by selecting only one object in it. 

 You can build up a library of blocks consisting of the parts that you require 

many times in your workday. These blocks can be stored in a separate folder 

and even on a network so that all drafters have access to them. 

 Using blocks can help keep your file size down. AutoCAD stores block 

definitions in its database. When you insert a block, AutoCAD only stores the 

name of the block, its location (insertion point), scale and rotation. This can 
be very noticeable in large drawing. 

 If you need to change something, you can redefine a block. For example, you 

draw a chair and turn it into a block. Later, you're told that the size of the 

chair has changed. Since you used a block you can redefine the block and all 

of your chairs are updated automatically. If you had drawn (or copied) 100 

chairs in your drawing, you would have to manually change each one. 

 Blocks can also contain non-graphical information. This means text objects 

called attributes. For example, you have made blocks of different chairs. You 

can add information to the block such manufacturer, cost, weight, etc. This 

information stays with the block, but can also be extracted to a database or 

spreadsheet. This would be useful for things such as a bill of materials. 

Attributes can also be visible or invisible in your drawing. Another good use of 

attributes could be a title block. 

 You can even easily add internet hyperlinks to blocks so you can connect a 

block to a page on a supplier's online catalog.  

There are two types of blocks you can create: blocks that are internal to your 

current drawing and those that are external, or saved as a separate file. To create 
the different types, different commands are used. 

Here are the commands that you will need for using blocks in this lesson: 

Command  Keystroke  Icon Menu  Result  

Block  
Bmake 

/ B  

Draw > Block 

> Make  

Creates a block from separate 

entities (internal to current 

drawing) 

Write Block Wblock / W 
None None Creates a block and writes it to a 

file (external) 
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Insert Insert / I 
 

Insert > 

Block 

Inserts a block (internal or 

external) 

For this assignment, you will be using any one of the floor plans you drew earlier in 
Lesson 2-1. 

Open the drawing. 

Zoom in to one section of the room close to a desk. 

Create a new layer called COMPUTERS (remember LA invokes the Layer Properties 

Manager) and make that layer current. 

Draw the computer as shown below. You do not have do dimension it. 

 

Start the BLOCK command by either typing B or using the pull down menu or the 

icon. You will see a dialog box that looks like the one shown (some versions of 

AutoCAD will have a slightly different dialog box (with different options). Enter 
information the same way though. 

 

1: The first thing that you want to do is give your block a name. Type COMPUTER in 
the edit box beside Block Name. 
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2: Now you need to select an insertion/base point. Pick the Pick Point button and 

then pick the midpoint of the bottom line. Make sure that the retain button is 

selected (this will keep your objects on the screen as individual objects. (Selecting 

the Pick Point with blocks is very important when you later insert them into the 
drawing - always pick a point that will allow you to place the block easily.)  

3: Next you want to select the objects for your block. Pick the Select Objects 

button and then select all the parts of your computer and press <ENTER>. Be careful 

not to select any other objects, or you just get to do it over again.  

4: Now select the drawing units you used to create the original objects in.  

5: This is optional, but you can add a description here. This is good if you are 

creating specific parts, like maybe a motor and want to add some quick 
specifications.  

6: Pick the OK Button and the dialog box closes. It will look like nothing happened, 

but the drawing file now has a "Block Definition" for a Computer in it. 

Congratulations, you have created your first block. 

If the default radio button "Convert to block" was checked, move your mouse over 

the objects and you will see that they all highlight - signifying that it is now one 
object.  

Now that you have created a block, it's time to insert it. Start the Insert command 
by typing I <ENTER>. You will see this dialog box on the screen: 

 

By default, all the options you need are pre-selected. Since you only have one block 

in your drawing, its name is displayed.  

Make sure that the Insertion Point - Specify On-screen box is checked, and the 

Explode button is not checked. The Scale - Specify On-screen should not be 

checked. Then press the OK button. Pick anywhere on your screen and you will see 
the block appear.  

Now insert a computer on every desk in your drawing. You can also copy the block 
instead of re-inserting each time, but make sure you know how to insert. 
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Copy the drawing below of the chair.  

 

This time you will be creating an external block using the wblock command. This 

difference here is that the block will become a separate, external drawing file for use 
in other CAD drawings.  

In the dialog box below, you will see that you have almost all the same options. 

Instead of giving the block a name like you did before, you give it a filename in a 
specific folder. 

 

Make sure you put the block in a logical path and give it a good, descriptive name.  

When you insert an external block, use the same Insert command that you did 

above and use the Browse button to navigate to the folder where you stored your 

block. Insert it like you did before. Put some chairs in front of the desks in your 
drawings, and rotate them if needed.  

Now you have created two blocks. The process is the same for any other block that 

you need to create from drawing objects. 

If you want more practice, draw more objects and create blocks from their geometry. 
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If you want to see how to update a block, modify the computer block by stretching 

the monitor portion at the top down by 8" (remember to fist explode the block). Now 

create a new block using the same COMPUTER name. After re-defining the block, you 
will see this box pop up to warn that you are about to update the block definition: 

 

Select Yes, and all your 'computer' blocks in the drawing will update to the new 
definition.  

This is a good example of how blocks save you time. In a typical work situation, the 

original specifications for the computer could have changed from large CRT monitors 

to flat screens and you would need to change them all. Using blocks is much easier 
than changing each individual object one at a time. 

Remember that blocks are powerful tools for the reasons listed above. In any 

discipline of CAD drafting, you will use them. They are powerful, yet easy to work 

with. Remember, Create the Block, Insert it - it's that simple. Your only choice is if 

you want an external or internal block. That choice depends entirely on how that 
block will be used.  

http://www.we-r-here.com/cad/tutorials/level_2/2-5.htm#reasons#reasons
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ATTRIBUTES 

So far in using AutoCAD you have created geometry: lines, circles, etc. You have 

also added things such as text and dimensions. All of these things could also be done 

by hand, so what else does CAD have to offer? 

As noted at the beginning of Level 1, AutoCAD is also a database of information. 

Most of that database contains the information for reproducing what you have 

drawn, but you can also add information that is non-graphical. One of the easiest 

ways of adding non-graphical information is to use attributes. An attribute is text 

that can be attached to a block to convey more information than just the geometry 
on its own could convey. 

Look at the two drawings below for an example: 

The first example shows some lines and arcs that could be anything. 

 

The second example shows the same geometry with the attributes visible so that you 

see what the shapes represent.  

 

The pictures above show a couch. The attributes describe what the model number, 

color and cost are as well as the manufacturer. From this simple example, you can 
see that AutoCAD has a useful tool for showing more than just geometry. 

This example shows information about furnishings in an office. Once you have drawn 

the floor plan, you could insert blocks of furniture that have information about the 

manufacturer, price, weight, and any other information you may need. This 

information can then be extracted out of AutoCAD and then used in a spreadsheet or 

other program which could generate a Bill of Materials. You can also use custom 

programs to use them in the CAD drawing. 

In this lesson you will be creating attributes and attaching them to the computer 

block that you made previously. Like everything you do in AutoCAD, there are 
particular steps involved when you work with attributes.  

1. First you have to define (or create) the attribute.  

2. Next you will create the block with attributes.  

3. Finally, when you insert the block you will give it the specific information.  
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Many of the commands that you will be using are tough to remember at first. You 

may find it easier to use icons (but then the icons look very similar). Pull down 

menus are another option, so you can see exactly what the command is that you are 
starting. 

Command  Keystroke  Icon  Menu  Result  

Define an 

attribute 

DDATTDEF 

/ ATT  

Draw > Block > 

Define Attribute 

Creates an 

attribute 

definition 

Edit attributes 
DDATTE / 

ATE <  

Modify> Object> Attar.> 

Single 

Edits the 

contents of an 

existing 

attribute 

Block 
Block / 

Bmake / B   

Draw > Block > 

Make 

Creates a block 

from separate 

entities and 

attributes. 

Display Atts. ATTDISP  None None 
Hides or shows 

attributes  

Extract 

Attributes 
EATTEXT 

 

Tools > Attribute 

Extraction... 

Extracts 

attributes using 

the wizard  

Open up the floor plans you drew earlier with the Computer blocks in Lesson 2-5. 

Insert a computer block and then explode it (type X <ENTER> and then select the 
block - press <ENTER>.)  

Begin the Attribute definition command: ATT (or) ATTDEF (or) DDATTDEF  

(AutoCAD has kept the commands from previous versions active in the new 

versions.)  

Look at the dialog box below. Fill in the edit boxes just like the example. Make sure 
to adjust the text height if necessary. 

http://www.we-r-here.com/cad/tutorials/level_2/2-5.htm
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What you did is give the attribute its definition - a name (tag), a prompt to help the 

user while they're inserting it, and a (default) value for the prompt. . 

Once everything is entered, select the OK button. 

When you are back on the drawing screen, pick a point near the middle of the 

computer block. When you are done, the dialog box comes back so press OK. 

Add the following attributes the same way, except instead of picking a point, check 

off the Align below previous attribute checkbox. 

TAG  PROMPT  VALUE  

MONITOR What is the MONITOR SIZE? XX" 

HDD 
What capacity is the Hard 

Drive? 
X.XXGB 

RAM  How much RAM is installed? XXXMB 

STATION What station is this  XXX 

 

Once all the attributes are created you should have something like this: 

 

Now create a block that includes your four attributes. 

 

Start up the BLOCK command. Create it as shown in the previous lesson. When 

you are asked for the block name, give it the name COMP-AT.  

http://www.we-r-here.com/cad/tutorials/level_2/2-5.htm
http://www.we-r-here.com/cad/tutorials/level_2/2-5.htm
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Insert the block and you will get a dialog box where you can enter the values for the 

tags. You will be prompted to provide answers to the prompts that you defined in the 

attributes. 

Command: I INSERT 

Specify insertion point or 

[Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:  

Enter attribute values 

what is the CPU Speed <XXX GHz>: 2.6 GHz 

what is the monitor size <XX">: 21" 

What is the capacity of the Hard Drive <XXX GB>: 200 GB 

How much ram is installed <XXX Mb>: 1024Mb  

what station is this? <XXX>: 104Mb 

After inserting the block and answering all the prompts, your block should look like 

this: 

 

Now by looking at the drawing, you can see exactly what 

type of computer it is and what station (location) it is. This is just one application, 

but you can see how it can be used in any discipline of drafting. You can either insert 
more blocks, or copy the one that is in the drawing. 

EDITING ATTRIBUTES: Of course, in any project, the data is subject to change. In 

this example, the company may decide that it cannot afford 24" monitors. You can 

easily change the value of attributes within a single block insertion by double-clicking 

on the block. That will bring up this dialog box: 

 

Remember that this will only edit the one block that you double-clicked on. If you 

want to change more than one block at a time to SAME values, you can select the 
blocks, then right-click and choose properties. 
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DISPLAYING ATTRIBUTES: Sometimes you don't want to see the attribute values 

displayed (say for plotting). You can turn them off. This can be done by typing in the 

command ATTDISP and then OFF. To turn them back on again, type ATTDISP and 
ON. It can't get much easier.  

EXTRACTING ATTRIBUTES: So now you're wondering what you can do with all of 

this information. A CAD drawing can be used to track inventory and export that data 

to another file for others to use. Maybe the purchasing department wants to know 

what to order, based on the design you are working on. 

Exporting the data became MUCH easier in recent versions of AutoCAD. 

Start up the EATTEXT command and you will see the wizard dialog box appear. 

Accept all the defaults and hit the Next button until you get to this step: 

 

Note that all the attributes are checked - including ones you don't want. Uncheck the 

Name property. Press Next. 

 

The image above shows the wizard step which allows you to organize the data. You 

can click and drag the column headings to sort the order of the data. You can also 

sort a column by clicking on the column header. Continue through the wizard and 

place the table in your drawing. Note that you can update the attributes in your 

blocks (as shown above) and AutoCAD will prompt you to update your table in the 
communication centre in the bottom right corner of your screen. 

http://www.we-r-here.com/cad/tutorials/level_4/4-9.htm


Dot Technologies, Gandhinagar 

 67 

 

Click on the Refresh Table Data text or right-click the table and choose the Update 
option. For more about tables in AutoCAD, please refer to lesson 4-9.  

Start the Attribute Extraction dialog again (EATTEXT) and choose this option on step 
4 to write the data to an external file instead of a table in the drawing.  

 

Continue through the wizard and save the data to a CSV file and finish. 

You can view the data in Notepad, or a spreadsheet program like Excel (as shown 

below) 

 

This is just a simple walkthrough of some of the power of AutoCAD. With more 

complex drawings and attributes, you can work wonders. Think about how easy it 

would be to build a table of all windows in a house plan if the windows were created 

as blocks with attributes. Some assembly drawings consist of nothing but standard 

blocks, this how much this simple process of creating attributes would help the 
workflow. Attributes are powerful - remember to use them.  

http://www.we-r-here.com/cad/tutorials/level_4/4-9.htm
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POLYLINES 

A polyline is an object in AutoCAD that consists of one or more line (or arc) 

segments. A rectangle is an example of a polyline that you are already familiar with. 

As you've seen, it is one object that can be modified and worked with easier than 
four separate lines. 

Polylines are created using the POLYLINE command, invoked by typing PL at the 

command line. To draw a simple polyline, draw it as though you are using the line 

command. The only difference is that it is one object instead of many. 

Polylines have some unique qualities that make them very useful: 

1. They can have width (constant or varying) 

2. They can consist of arcs and lines. 

3. They can be edited 

4. They can be joined together. 

5. They can be exploded into individual segments 

Command  Keystroke  Icon  Menu  Result  

Polyline  Pline / PL  

 

Draw > 

Polyline  

Creates a polyline of arcs 

and/or lines.  

Polyline Edit Pedit / PE 

 

Modify > 

Polyline 

Edits polyline objects 

 

When you start the command, you will notice that there are several options 

available:  

Command: Pl PLINE 

Specify start point:  

Current line-width is 0.0000 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 

Remember that any time you want to choose an option, you type in the Capitol letter 
of that option. 

To edit a polyline, use the PEDIT command or type PE at the command line. 

Command: pe PEDIT Select polyline or [Multiple]: 

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype  

gen/Undo]: 

 

One of the most common editing tools is the Join (J) option. Use this to combine 
two or more polylines. 
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Another important tool is the Close option. This truly closes a polyline, which is 

different that just having two ends meeting at the same point. A closed polyline is 

required for extruding into 3-D space and other modifications. If you use the CL 
option while drawing to complete your polyline, it will automatically be closed. 

The Spline option allows you to draw a shape of lines using arcs and/or straight 
lines and then change them into one flowing curve. 

Also by changing the width of a polyline, you can get some different looks to your 
lines. 

Look at the examples below and then practice drawing polylines and try some of the 
options available. 

 

Below is a sample drawing you can reproduce using a polyline. First, think about how 
you would draw it using lines, arcs and circles.  

 

Here's how you draw it using one polyline: 

Command: pl PLINE 

Specify start point: <pick a point>  

Current line-width is 0.0000 

Specify next point or [Arc/Half width/Length/Undo/Width]: 5 

Specify next point or [Arc/Close/Half width/Length/Undo/Width]: a 

Specify endpoint of arc or 

[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second 

pt/Undo/Width]: 2 

Specify endpoint of arc or 

[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second 

pt/Undo/Width]: l 

Specify next point or [Arc/Close/Half width/Length/Undo/Width]: 5 

Specify next point or [Arc/Close/Half width/Length/Undo/Width]: a 

Specify endpoint of arc or 

[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second 
pt/Undo/Width]: cl 
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Remember DDE? Start by entering your first point, then (with Ortho on) move your 

cursor to the right and type 5 <ENTER> then A <ENTER> for arc and move your 

cursor up and type 2 <ENTER> then type L <ENTER> (to go back to straight lines) 

and more your cursor to the left and type 5 <ENTER> then back to arc (A 
<ENTER>) and then type CL to close the polyline. 

Now the shape is complete and you can offset it, scale it, etc., as one object. In 3D, 
you could also extrude it. 

Polylines are useful - try to use them whenever possible. Sometimes you can draw 

the outside walls of a building, offset the polyline for the wall thickness, and then 
explode both of them for more versatility. 

http://www.we-r-here.com/cad/tutorials/level_1/1-9.htm#dde
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HATCHING 

Hatching in AutoCAD is a way of filling in areas of your drawing with a pre-formatted 

pattern to represent certain materials. It is usually used in sectional views. Starting 

with AutoCAD release 14, you can use a solid fill to completely fill in areas such as 
walls in a floor plan. 

There are two types of hatching you can use. Generally you will want use the 
BOUNDARY HATCH command.  

Command Keystroke Icon Menu Result 

Boundary 

Hatch 
Batch / H   Draw > Hatch 

Covers an area with a 

predefined pattern 

Hatch Edit 
HatchEdit / 

HE   

Modify > 

Object > 

Hatch... 

Edits an existing Hatch 

Draw a rectangle 10 units by 10 units and put a circle with 2" radius in the middle of 

it. 

Start the Boundary Hatch by typing H <ENTER>. When you start the command, you 
will this dialog box appear: 

 

As usual, start at the top of the dialog box and work your way down. We're going to 

say that this is a cross section of piece of steel, so choose the predefined Hatch 
pattern called STEEL.  

Now you want to pick the area to be hatched. Pick somewhere inside the rectangle, 
but outside of the circle and press <ENTER>. 

Set the scale of the hatch to 6. This is just a number that works for this object. A 

larger number will make the hatch bigger (maybe so big you won't see it) and a 

smaller number can make the hatch so dense that it looks solid. 

Make this "Associative" - this means that if you adjust the rectangle or circle, the 
hatch will automatically correct itself to the new boundary. 
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Finally, hit the Preview button to see if this is what you are after; it should match 
the image below.  

 

Note that AutoCAD recognized the circle in the middle and didn't hatch over it. If the 

lines appear 'jagged', don't worry - it is a video issue -the prints will come out clean 
and straight. 

If you want to edit the hatch, the easiest way is to just double-click on it. (If you 

can't double-click on it, type in HE <ENTER>). This will bring up the same dialog box 

(almost) that you just used to create the hatch. Try different settings in the Hatch 
Edit dialog box and preview the results. 

To see what "Hatch Association" is, pick on the rectangle (be careful not to select the 

hatch) and you'll see 4 squares appear on the corners. Click and drag one of the 

corners and release it. If you hatch is associative, it will update to the new shape. 

TIPS: 

If you are using a solid hatch, make the hatch WHITE so that it will print out as a 
solid black, any other color will appear gray (with lines) when printed. 

If you have one hatch area drawn and want it to match the hatch of another, use the 
"Inherit Properties" button on the Hatch Edit dialog box.  

In recent versions, you can add a 2 color gradient to an object. Look for the 

"Gradient" tab at the top of the Hatch dialog boxes. Below is a sample of a really 
basic 2D 'rendering' using this method? 

 

You can create custom hatch patterns, or find custom ones available on the internet. 
Another site offers some free ones as well as extensive collections for sale.  

Hatches can be exploded - but be VERY careful if you do this. In fact, don't explode 
hatch patterns unless you really need to.  

There is a setting in the Tools > Options dialog box under the drafting tab that allows 
you to turn on or off the ability to snap to hatch objects. Off is the default. 

This completes Level 2 - if you would like another project to test out your new skills, 

try re-creating this floor plan of a cabin. 

  GIF File  DWG File 

Cabin Floor Plan 
  

http://www.hatchpatterns.com/newhp.htm
http://www.hatchpatterns.com/
http://www.we-r-here.com/cad/tutorials/level_2/images/cabin_floor.gif
http://www.we-r-here.com/cad/tutorials/level_2/links/cabin_floor_plan.dwg
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INTRODUCTION - WHY 3-D? 

You may have already found out why CAD has many advantages over manual 

drafting. One big advantage is that once you've drawn something, you shouldn't 

have to draw it again. If you manually drew a house plan, you would have to draw a 

front elevation, side elevations, and possibly a perspective view. With one 3-D CAD 

model, you can generate views from any angle either inside or outside the house. 

Afterwards, if your client needs something changed, you can then make the changes 

once. If you're drawing mechanical parts, you can generate virtual prototypes or 

even create rapid prototypes. In this manner Boeing was able to design and 

prototype the 777 jetliner. This level of engineering would be impossible without 

CAD. 

You'll be learning the 3-D concepts in the following order: 

o Isometric Drawings (not true 3D)  

o Wire-frame 

o Surfaces / Regions 
o Solid Objects 

You will have a chance to draw the same object different ways to see the differences 

between the various methods.  

Before entering the exciting world of 3-D, you'll have to learn some more CAD 
terminology 

3-D CAD TERMINOLOGY 

2-D  
A concept of displaying real-world objects on a flat surface showing 

only height and width. This system uses only the X and Y axes.  

3-D  

A way of displaying real-world object in a more natural way by 

adding depth to the height and width. This system uses the X Y and Z 

axes.  

Boolean 

operations  

Commands that allow you to add subtract or intersect solid objects in 

AutoCAD.  

Complex 

surface  

Generally a curved surface. Examples: car fender, landscape contour.  

Elevation  
The difference between an object being at zero on the Z-axis and the 

height that it is above zero.  

Extrude 
The extrude command raises the shape of a 2D outline into a 3D 

solid. For example, a circle would be extruded into a cylinder. 

Face The simplest true 3-D surface.  

Facet  
A three or four sided polygon that represents a piece (or section) of a 

3-D surface. 

Hidden A way of hiding lines that would not be visible if you were viewing the 

http://www.boeing.com/commercial/777family/compute/compute2.html
http://www.boeing.com/commercial/777family/compute/compute2.html
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm
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line 

removal  

actual object you have drawn in AutoCAD. (Command: HIDE)  

Isometric 

Drawing  

A simple way of achieving a '3-D' appearance using 2-D drawing 

methods.  

Plan View  
Also known as the top view, a plan view looks directly down the WCS 

Z-axis to the X-Y axis.  

Primitive  
A basic solid building block. Examples would be boxes, cones, 

cylinders.  

Region  A 2-D area consisting of lines, arcs, etc.  

Rendering  
A complex way of adding photo-realistic qualities to a 3-D model you 

have created.  

Shading 
A quick way of adding color to a 3-D object you have drawn. 

(Command: SHADE)  

Solid 

Model 

A 3-D model creating using solid 'building blocks'. This is the most 

accurate way of representing real-world objects in CAD.  

Surface 

Model  

A 3-D model defined by surfaces. The surface consists of polygons. 

(See facets.)  

Thickness  
A property of lines and other objects that give them a 3-D like 

appearance.  

UCS  
The user co-ordinate system. This is defined by the person drawing 

to have easier access to portions of a 3-D model.  

View A particular view of the object you have created.  

View port  

A window into your drawing showing a particular view. You can have 

several view ports on your screen. Different from the view ports used 

in plotting.  

Wire-

frame 

Model  

A 3-D shape that is defined by lines and curves. A skeletal 

representation. Hidden line removal is not possible with this model.  

Z-Axis  The third axis that defines the depth.  

As computers and software get more sophisticated, working in 3D becomes more 

popular. You have more power in desktop machine today, than was dreamed of 

when CAD first appeared. Be prepared that you will likely need to learn 3D at some 

point in your career. Once you are comfortable working in 3D, you'll find that you will 

rarely want to draw in 2D again. Autodesk (the makers of AutoCAD) make other 

products designed specifically for certain disciplines - Architectural Desktop, Map, 3D 

Studio Max and more. Depending upon your budget and needs, you may need to 

look into programs like these. The concepts taught in these lessons will aid you when 
you work in any 3D program.  

http://www.we-r-here.com/cad/tutorials/level_3/3-2.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-2.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-7.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-9.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-6.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-12.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-4.htm
http://www.we-r-here.com/cad/tutorials/level_2/2-4.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-5.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-5.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-5.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-3.htm
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LESSON 3-2 - ISOMETRIC DRAWING 

Using Isometric commands is one of the simplest ways to give a 3-D representation 

while using only 2-D commands. This has been the usual way of doing things before 

CAD allowed true 3-D work to be done. Many times an isometric drawing is used to 
compliment a 3 view orthographic drawing. See the sample below. 

 

You can see that it is a very simple drawing. The basic isometric drawing of the 

object gives a very good idea of what it looks like. If this is all that is needed then 

isometric works well. Unfortunately, as soon as you change anything, like the block's 
height, you'll need to redraw all four views. 

AutoCAD has a command called ISOPLANE which allows you to easily draw at a 30 

degree angle as needed for an isometric drawing. You can switch between the three 
'isoplanes' (top, right, left) by using this command or by pressing the F5 key. 

Command: ISOPLANE <ENTER>  

Current isoplane: Right 

Enter isometric plane setting [Left/Top/Right] <Left>: T <ENTER> 
Current isoplane: Top 

By invoking this command, AutoCAD is now set to draw on the top isoplane. Your 

other choices would be Left or Right. Your first exercise will be to draw the object 

shown above using isometric methods. 
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ISOMETRIC DRAWING 

Begin a new drawing using the acad.dwt template  

Create a layer called OBJECT and give it a green color. Make this your current layer.  

Type in DDRMODES to bring up the Drawing Aids dialog box. Make your settings the 
same as what you see below (just turn on Isometric Snap). 

 

Press OK and you'll see that the grid is set up for isometric drawing for the left 

isoplane in 1/2" increments. Your crosshairs are now angled to show you which 

isoplane you are currently on and the Grid is laid out differently from what you may 
be used to... 

Begin by drawing the left side of the box (shown at the top of the lesson) using the 

line command. Ignore the hole at this point. You will want to use the Direct Distance 

Entry System for this exercise and make sure that you have Ortho (F8) and Osnaps 
(F3) turned on. 

Switch to your right isoplane (F5) and draw the right side. 

Switch to your top isoplane (F5) and draw the top view. 

Create the angle lines to add the angled surface. 

Switch back to the left isoplane and start the ellipse command. At the command 

prompt, press I for is circle. This will allow you to create an ellipse at the correct 

angle based on the radius of the circle in the orthographic drawing. Use the Osnap to 
pick the correct center point. 

Save your drawing in your CAD folder. 

Practice this method with some other simple block objects, but keep in mind that this 

is still only 2D. Remember that in some instances, it may be quicker and easier to 

use this method rather than the more complex 3-D methods you'll be learning in the 
following lessons.  

http://www.we-r-here.com/cad/tutorials/level_1/1-2.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-8.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-9.htm
http://www.we-r-here.com/cad/tutorials/level_1/1-9.htm
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WORKING IN 3 DIMENSIONS 

THE 3-D CO-ORDINATE SYSTEM  

By now you should be very comfortable working your way around the X-Y co-

ordinate system. Anyway, here is a quick review. Looking from the plan (top) view, 

this is what you see to figure out where is positive X and positive Y. 

 

If you were to look at the same picture, but at a slight angle, you would see the third 

axis. This new axis is called the Z-axis. Imagine that the positive Z-axis is coming 
towards you out of the monitor. 

 

The Z-axis has always been there, lurking in the background, waiting for you. 

When you entered points previously, you would enter them in the format: X, Y. by 

doing this, you let AutoCAD know that in these cases, Z was equal to zero. Entering 

4, 3 would be the same as entering 4, 3, and 0. Now if you drew a line from the 

origin (0, 0, and 0) to a point at 4, 3, 2, you would get a line that goes 4 inches to 

the right, 3 inches up and 2 inches towards you. The properties of this line would be 
this: 
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Notice that the line is actually 5.3852" long. If you were to look at it from the plan 

view, it would look exactly like a line drawn from 0, 0 to 4, 3 Draw it and then check 

the properties. 

The diagrams below show this line from 4 different views to illustrate how things can 

look different in 3D. Look at each one carefully, and see if it makes sense to you.  

 

This is the usual view you have 

seen when using AutoCAD in 2D. 

You are looking straight down the Z 

axis (positive Z is pointing at your). 

It looks like any other line you have 

drawn, going from 0, 0 to 4, and 3 

- but there is a difference...  

 

If you were to look at the line from 

the front, instead of the top (as 

shown above) you would be able to 

notice the elevation of 2 units in 

the Z axis. This is the same line as 

above, only viewed from a different 

angle. In this view, you are looking 

straight down the -Y axis.  

 

Just for fun, here is the same line 

but viewed from the left. This would 

be looking down the -X axis.  

 

Finally, here is the line as viewed in 

3D space from the Southeast view.  

What the above images show you is that you will have to get used to looking at a 3D 

world on a 2D monitor. In each image, the black line looks flat, but you have to use 

your reference points to determine where it truly is. If you don't understand this 

perfectly right now, don't worry. It's just an exercise to expose you to 3D viewing. As 
the lessons progress, you will get much more familiar to this.  

Why is this important to look at before entering the world of 3-D? If you were 

to only look at a 3-D model from the plan (top) view, you would not be able to see 

any difference between the two lines. (Draw them and see for yourself) On a 3-D 

model, you can easily have many points over top of each other. This would be very 

difficult to work with. You may think you're snapping to a particular endpoint, but the 

reality of it could be very different (think of how the top of the wall looks the same 

as the bottom of the wall if you're looking straight down it). Fortunately, AutoCAD 
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provides different viewing options for 3-D drafting. This will be discussed in a later 

lesson, but for now, if you want to see your 2 lines in a view similar the Z-Axis image 

above, go to your menu called View > 3D Views > SW Isometric. You'll see the lines 
that look identical in the top view, look very different when viewed from an angle. 

Now for the confusing part. You already know how to rotate 2D objects, but you also 

have to know how AutoCAD measures angles of rotation in 3-D. There is a somewhat 

simple rule for this called "The Right Hand Rule". To figure out which is the positive 

rotation angle, imagine that you are wrapping your right hand around the axis with 

your thumb pointing towards the positive end. The direction that your fingers are 
wrapped is the positive direction. This applies to all three axes. 

 
DIRECTION OF POSITIVE ROTATION 

The main point of this lesson is to tell you that objects can trick you in 3D space. 

Shortcuts don't always work, you have to be careful with Osnaps and your drawing 

can turn into a mess very quickly if you're not paying attention. Trust me, 

I've seen enough students take the easy route and have to start over. If you want to 

learn 3D review each lesson before progressing. Make sure you know the concepts 
inside and out.  
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VIEWING 3-D OBJECTS 

AutoCAD has a few ways for you to view an object other than the plan view that you 
have used for your 2-D drawings.  

For quick, easy views use the pull-down menu options. To do this choose View > 3-

D Viewpoint > (then select one of the four bottom isometric options). Look at the 

drawing below to see the differences between four views. When doing basic 

drawings, it is a good idea to use only one view. This will keep you orientated a lot 

easier. It is most common to use the Southwest view, as this keeps your positive X 

and Y axes in a logical position. For most of your work in this course, stick with this 

view.  

There will be times when you may need to see around to the other side of your 

object. 

Then you can easily use the other preset views to see your model. You can also have 
more than one view on your screen at a time. See below: 

 

To achieve this, use the Tiled View ports option of the View pull-down menu. 

Then choose the New View ports tab, and pick from several layouts. Any view or 

view port configuration can be saved under a unique name. Later you can easily 

restore this view when needed. Here are the preset view port configurations that you 

can use in model space. 

 

As you can see, you can select options for 2D or 3D, and change the view by picking 
in one of the view ports and selecting a new view in the droplist.  

Here are a few general notes about views and view ports: 
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 You can have view ports in either model space (tiled) or paper space 

(floating).  

 They can have different zoom ratios. 

 There is a difference between views and view ports. 

 If you go to a lot of work to get a view you need, save it using the VIEW 

command. 

 When saving a view, give it a descriptive name. 

 Keep an eye on the UCS icon in the corner of the screen or view port. 

 The smaller your monitor is, the harder it is to see tiled view ports. 
 When you have more than one view port, click inside the one you want active. 

To practice viewing your 3D drawing, open up up this simple 3D file of a table and 

chairs. Change to different view port layouts. Try some of the different Isometric 

views. Depending upon the size of your monitor, it may not be practical to use 

multiple view ports. In the end it is a matter of personal preference that decides 

what setup you are comfortable drawing in. 

Change back to 1 view port (View > View ports > 1 View port) and switch to the SW 

Isometric view.  

PERSPECTIVE VIEWS 

There is another command called DVIEW (Dynamic View) that gives you more 

control over the view of your object. It will also allow you to see a perspective view 

of your model. This can be a very confusing method if you don't have a system. 
What follows is my approach to creating perspective views. 

The basis of generating a perspective view is to have a virtual camera and target. 

Think of where you would like to 'stand' (the camera) and what direction you want to 
look at (the target). 

In this example, I want a view that gives me slight perspective view of the table and 
chairs. The first thing I need to do is draw a point for my 'camera'.  

Draw a line from the centre of the bottom leg 6' in the negative X axis. Now draw a 

line 5'6" straight up (@0, 0, 5’6) - and finally draw a line to the middle of the far 

end of the table. It should look like this: 

 

Now start the Dview command. You will be asked to select objects. You can select 

everything, or for the purposes of setting points, I would normally just choose the 

http://www.we-r-here.com/cad/tutorials/level_2/2-4.htm
http://www.we-r-here.com/cad/tutorials/level_3/links/table-4-chairs.dwg
http://www.we-r-here.com/cad/tutorials/level_3/links/table-4-chairs.dwg
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line as it makes the command faster in large drawings. 

Select the top line to the middle of the table. <ENTER> 

Choose the Points option by typing in PO <ENTER> 

Now you have to select the Target - pick the right endpoint of the line (use Osnaps)  

Next select the Camera - pick the left endpoint of the line. 

It will look like the line disappeared, but you now looking straight down it. 

Press <ENTER> to end the command. 

 

Start the DVIEW command again and select all the objects. In larger drawings, 

select the objects that furthest to the extents of the drawing (this will same time and 

let you know the limits of your view) and any objects that are critical to your view. 

What this means in that if you are using the command on a very large drawing, the 

DVIEW command can bog down (slow down) your system to a crawl. By selecting 

only the ones on the outside limits of your drawing, you will still be able to use the 

command quickly and efficiently. 

This time, choose the Distance option by pressing D <ENTER>. This option 

effectively zooms in and out while in a perspective dynamic view. 

Move the slider at the top until it is just right of the '1x' and then left click with your 

mouse. 
Note that slower computers will take longer to regenerate the drawing for you.  

 

While still in the Dview command, type in PA for the Pan option and move the table 
and chairs up slightly in the drawing area so that they are centered. 

And lastly, type in H for the hide option for a more realistic view. And then press 
<ENTER>. 

You will notice that certain commands do not function while in a perspective view. 

For example, you can not zoom or pan the usual way. I recommend that you don't 

edit your drawing in this view. 

To preserve this view that you worked so hard to achieve, type in V (for view) and 

select the new button and give your view a name. Now when you need to go back to 

this view you just type in V again, select your named view, press the Set Current 
button and press OK. 



Dot Technologies, Gandhinagar 

 83 

 

If you are using this command on larger drawings, like a home or building, the same 

process is used, but you should create the camera location to be further away from 

the objects you want to view. Practice makes perfect and this command can take 

some trial and error sometimes to get it just right. In the end, it is a very powerful 

viewing tool. When practicing, save views so you can go back to them if needed - it 

will save you a lot of time.  
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BASIC WIRE-FRAME MODELS 

In this lesson, you will be drawing two objects. First, you will draw the shape from 

the isometric exercise (refer to that exercise for dimensions) using the same line 

command that you have always used. Then you will draw a simple chair using the 

same method. This will be good practice to work on the XYZ co-ordinate system. 

Wire frame models are the simplest form of true 3D drawings. They can be used for 

conversion to other programs or other simple uses. Still, this is not a common way of 

drawing in 3D these days. 

Start a new drawing using the acad.dwt template.  

Create a layer called OBJECT and give it a green color. Make this your current layer.  

Using the line command, draw the outline of the front view placing the bottom left 

corner at 0,0,0 Then draw the circle. 

Copy the outline and circle 2" up in the Z-axis. When asked for the base point, select 
anywhere on the screen, and copy it relative to the base-point: @0, 0, and 2 

Switch your view to the SW Isometric view. 

Notice that you have the front and the back drawn now. Using your endpoint Osnap, 
connect the corners of the object. 

Your drawing should look like this: 

 

Pick any line and snap to an endpoint grip. Look at the co-ordinate display on the left 

of your status bar and see if it makes sense to you. Try this at other points. What 

you have just done is created a simple object in 3D drawing space. It has length, 

depth and height. Get used to looking at it, and review what you did to create it.  

Save your drawing under the name wireframe1.dwg. 

EXERCISE 2 

Start a new drawing using the acad.dwt template.  

Create 3 layers called SIDES, SEAT, and BACK and give them different colors. Make 

back your current layer. Multiple layers make your drawing easier to work with - 

trust me. 

Look at the drawing below. This is the basic chair shape that you will be drawing a 

few different ways in this course. For this lesson, you'll be using rectangles. Switch 

to your SE Isometric view.  

http://www.we-r-here.com/cad/tutorials/level_3/3-2.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-4.htm
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Start with the back. Make rectangle to define the plan view of the back of the chair. 
Copy it 34" in the Z-axis and then connect the corners with vertical lines. 

Next draw the sides (on the side’s layer). Use the same method you used for 
drawing the back (except copy them up 24") 

Once you have drawn one side, you can copy or mirror it to make the other side. 

Finish up by drawing the seat. This will take a bit of thought as you have to make it 

fit between the sides. Start by drawing the rectangle for the seat in the correct 

location, and then move it up 12" so that it is at the correct elevation. After that, 
copy it up 4" and connect the corners.  

Save the file as wirefame2.dwg in your CAD folder. 

Try to get the view port configuration you see below using tiled view ports 

 

You don't need to dimension this drawing, but use the distance command to confirm 

that the sizes are correct. 

When you are sure that your drawing is correct, save it again for later use. 

From these simple exercises, you can see that the world of 3D (so far) isn't really 

different from 2D. You used the same line, copy, move commands that you would 

draw in a 2D world. The only difference is that you added the Z co-ordinate to give 

your point 'height'. Once again, make sure you are familiar with what happened in 

this lesson before moving on to the next. Redo it if you have to, but get used to the 
concept of height.  
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LINE THICKNESS 

In this lesson you'll create the same chair by drawing lines and then giving them 

thickness. Think of thickness as the height of the line or how tall it is. This is 

different from the width of the line that you learned in the polyline lesson. This is a 

quick, simple way of achieving some degree of 3-D feel. Once again, remember that 

in some instances, simple concepts may do the job. This is also a good technique for 

AutoCAD LT users, who don't have the option to draw in true 3-D. 

Start a new drawing using the acad.dwt template.  

Create 3 layers called SIDES, SEAT, BACK and give them different colors. Make 

back your current layer.  

Look at the drawing of the chair in Lesson 3-5.  

Draw rectangles to create the back, sides and seat on their respective layers (as if 

you were drawing the top view). Do not worry about height, thickness or anything 
but the basic outline of the top view. 

Select the properties icon. When asked to select an object, select the polyline 
that will become the back of the chair.  

You'll see the Modify Polyline dialog box pop up and it should look like the one below. 

 

For this lesson, there are two important areas to look at. Make sure that your line is 

located at Z=0. From there you want to go into the Thickness text box and enter 

34. This will give you a polyline that is based where you drew it and will be 34" thick, 

meaning that it will extend 34" in the positive Z-axis. (Entering a negative number 

will extend the thickness in the negative Z-axis.) 

Change the properties of the sides and give them a thickness of 24". 

http://www.we-r-here.com/cad/tutorials/level_3/3-5.htm#chair
http://www.we-r-here.com/cad/tutorials/level_2/2-7.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-5.htm#chair
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Give the seat a thickness of 4 inches. The seat should be based on Z=0. To move it 

up to the correct location, enter the move command and give it a displacement of 

@0, 0, and 12. 

Look at your drawing in the SW isometric 3-D view and it should look like the one 

you drew in the wire-frame exercise. There is one major difference between the two 

models. As stated earlier, wire-frame models do not allow you to hide lines that you 

not see in the real world. With your cursor in the SW isometric view port, enter the 

command HIDE. You should see that your chair now looks like the one below. 

 

You'll see that it is now starting to look like a chair. It's not perfect yet. You can still 
see the sides through the seat and the tops of the sides and back are hollow. 

Save the drawing under the name chair_line_thickness.dwg in your CAD folder 
(you'll use it in the next lesson). 

So far you have learnt two ways to construct a 3-D-like object and still haven't learnt 

any new drawing commands. These methods use 2-D commands to achieve 3-D 

appearances. Another advantage of these methods is that they can be used in 
AutoCAD LT, which doesn't have any true 3-D capabilities at all. 
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REGIONS AND 3-D SURFACES 

In this lesson, you'll begin using true 3-D commands. First you will create a 2-D 

region and then extrude it into a 3-D solid. Then you will add 3-D surfaces to the 

tops of your previous drawing (line thickness) to close the back, sides and seat. 

Begin a new drawing with the acad.dwt template. 

Create 3 layers called SIDES, SEAT, and BACK and give them different colors.  

Draw the outlines (using rectangles) of the back, sides and seat as you did in Lesson 
3-5, but don't add line thickness. 

You'll start by creating a region for the back of the chair. Make sure that back is your 

current layer. (Any region you create will be on the current layer, regardless of which 

layer the object was on when you selected it.) Start the region command by entering 

REGION (or REG) at the command line. Pick the polyline that will become the back 
of the chair and press enter. Your command line should look like this: 

Command: region <ENTER>  

Select objects: 1 found 

Select objects:  

1 loop extracted. 

If the Region wasn't created, it usually means that you have a gap in the shape. 

Polylines must be closed to be used for Regions. Repeat this for the other polylines 

representing the 2 arms and the seat, ensuring that you have the correct layer 
current.  

At this point, you have four 2-D regions. The next step is to extrude them into 3-D 

solid objects. Make BACK the current layer and start the EXTRUDE command. Pick 

the region on the back layer. Look at the command line. You will be asked a few 
things: 

Command: EXT EXTRUDE 

Current wire frame density: ISOLINES=4 

Select objects: 1 found 

Select objects:  

Specify height of extrusion or [Path]: 34 

Specify angle of taper for extrusion <0>: 

The first thing that AutoCAD needs is the height of the extrusion. This is similar to 

the thickness that you gave the polylines in lesson 5. Remember that if you give a 

positive number, it will extrude in the positive Z-axis. If you give a negative number, 

it will extrude the region in the negative Z-axis. Then you are asked for the 

'Extrusion Taper Angle'. In most cases this will be the default of zero. Press <enter> 
to accept the default. 

Note: You can also extrude directly from rectangles, circles and closed polylines, but 
I wanted to show you the Region command.  

http://www.we-r-here.com/cad/tutorials/level_3/3-5.htm#chair
http://www.we-r-here.com/cad/tutorials/level_3/3-5.htm#chair
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Extrude the sides and seat. Remember to move the seat up 12" if you haven't 

already. Check that the model is correct by viewing it in the SW isometric view. Type 

HIDE (HI) and you should see a solid chair like the one below. 

 

Now you can see how solids are a good way to go in some cases. They will usually 

give you the most accurate way of viewing the model. You can also get a lot of 

information out of a solid. Use the pull-down menus to access the Mass Properties 

commands. (Tools> Inquiry> Mass Properties) Click on one of the solid objects. 

You'll see that AutoCAD can give you a lot of information about it. A lot of these are 

useful in engineering applications, but the volume is something that may be needed 

in many different instances. As you'll see in the next lessons, you can do a lot with 
solids. 

Save your drawing under the name: chair_extruded.dwg 

NEW PROJECT  

Open your chair_line_thickness.dwg drawing and immediately save it under a 
new name: chair_3D_face.dwg 

What you're going to do is add 3-D faces to the tops of the back, sides and sides. 

Begin by viewing your model in the SW Isometric view. Type hides to see where you 

need to cap off the extruded lines. Type REGEN or RE to regenerate your screen so 
you can see all the corners again. 

Make sure that BACK is the current layer. Type 3DFACE to begin the command. You 
will be asked to select some points. Make sure that your endpoint Osnaps are on. 

When asked to pick the points, select them in the order as if you were drawing a 

rectangle. Do not go from one corner to an opposite one. After you have picked the 
fourth corner, press (enter). Your command line should look like this: 

Command: 3dface Specify first point or [Invisible]: (Pick 1)  

Specify second point or [Invisible]: (Pick 2)  

Specify third point or [Invisible] <exit>: (Pick 3)  

Specify fourth point or [Invisible] <create three-sided face>: (Pick 4)  
Specify third point or [Invisible] <exit> : <ENTER>  
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Repeat the command to add 3-D faces to the top of the sides and the seat. 3D faces 

are great for making odd shapes that include any four lines (or arcs) that are 

touching). 

Enter the HIDE commands to check that it was done correctly. If it all worked, you 

should see an image identical to the solid model. You'll notice that the 3D face 

covers what would be the opening at the top of the arms and the back. If it was done 
incorrectly, there may be a line running down from the back corner of each piece. 

Save the file. 

Now you have created some true 3-D objects. Take some time to think about how 

much work was involved in each method: Wire frame, line thickness and extruding. 

Think about instances where one might be better than the other. Review the 
methods that you have used so far:  
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EXTRUDING TO CREATE 3D OBJECTS 

The purpose of this lesson is to look further at the EXTRUDE command. As you saw 

in Lesson 3-7, it can be used to create a 3D solid from a closed 2D shape. Two other 

ways you can extrude (which you may have seen as options on the command line) 

are to taper the extrusion and the extrude a shape along a path. If you need to, you 

can also combine the two options and extrude along a path while tapering the shape 

(shown below). 

 

One example where you can use extruded paths is to represent pipes in a drawing. 

You may not use the tapered path option, but at least it's there. 

EXTRUDING ALONG A PATH 

Draw a POLYLINE from 0, 0 to 120, and 0 to 120,120 to 240,120 to 240, 0 and 
then press <Enter> to finish the command. 

Do a Zoom > Extents to see the polyline and then zoom out a little more. Your line 
should look like this: 

 

Next you will put a 24 unit radius on all the corners. The easiest way to do this is 
using the Polyline option of the FILLET command.  

Command: F <ENTER> 

FILLET 

Current settings: Mode = TRIM, Radius = 0.0000 

Select first object or [Polyline/Radius/Trim/mUltiple]: R 

Specify fillet radius <0.0000>: 24 

Select first object or [Polyline/Radius/Trim/mUltiple]: P 

Select 2D polyline: <SELECT THE POLYLINE>  
3 lines were filleted 
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What you're going to do next is extrude a circle a long the polyline - or to be more 

accurate, the path of the polyline. This would be one way of drawing pipes in 3D. For 

this example, you'll draw a pipeline with a diameter of 12 units. 

Next draw CIRCLE at the bottom right end of polyline. Use a diameter of 12 (radius 

of 6). Once you have that, you need to rotate it in 3D. This is covered in the next 

lesson as well. To do this, you will select the circle, select the axis you want it 
rotated around and then choose the angle. 

Command: ROTATE3D 

Current positive angle: ANGDIR=counterclockwise ANGBASE=0 

Select objects: <SELECT THE CIRCLE> 1 found 

Select objects: <ENTER> 

Specify first point on axis or define axis by 

[Object/Last/View/Xaxis/Yaxis/Zaxis/2points]: X Specify a point on the X 

axis  

<0,0,0>: <SELECT THE BOTTOM RIGHT END OF THE POLYLINE - Make sure your 

Osnaps are on for endpoints> 

Specify rotation angle or [Reference]: 90 <ENTER> 

Your circle should have rotated 90 degrees and now you are looking at the side of it 
so the circle appears to be a line as shown in the image below. 

 

Now comes the easy part. Next you will EXTRUDE the circle along the path of the 
polyline. 

Command: EXT 

EXTRUDE 

Current wire frame density: ISOLINES=4 

Select objects: <SELECT THE CIRCLE> 1 found 

Select objects: <ENTER> 

Specify height of extrusion or [Path]: P 

Select extrusion path or [Taper angle]: <SELECT THE PLINE>  

Note: After the Extrude command, the polyline will still be there. If you need to keep 

your drawing clean, remember to erase the path if you don't need it any more. To 

see how it looks, view the object in the SW Isometric view, and use the HIDE 
command. It should look like this: 

 

This is just one option available with the Extrude command. Try it on other paths and 

see how it works. You will find that if your circle is too large, it may not be able to be 

extruded on polylines with tight corners. Any object that can be extruded can be 

http://www.we-r-here.com/cad/tutorials/level_3/3-8.htm#rotate3d
http://www.we-r-here.com/cad/tutorials/level_3/3-8.htm#rotate3d
http://www.we-r-here.com/cad/tutorials/level_3/3-4.htm#swiso
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extruded along a path. A path can be any open object such as lines, arc, polylines, 
splines, etc. 

For more practice, try to created a cord for your lamp (Lesson 3-8) using a Spline as 

the path. You can also extrude 2 circles along a path (make one one circle smaller) 

and then subtract the smaller diameter extrusion from the larger to create a hollow 
pipe. 

EXTRUDING WITH A TAPER  

Extruding along a taper gives you another option in your 3D toolbox. Here is an 
example of how it is done: 

Draw a RECTANGLE 100 units by 100 units. 

EXTRUDE the Rectangle 50 units high with a taper angle of 45 °. Here are the 
commands needed.  

Command: REC  

RECTANG 

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 0, 

0 
Specify other corner point or [Dimensions]: 100,100 

Command: EXT  

EXTRUDE 

Current wire frame density: ISOLINES=4 

Select objects to extrude: <SELECT THE RECTANGLE> l 
1 found 

Select objects to extrude: <PRESS ENTER>  

Specify height of extrusion or [Direction/Path/Taper angle] <1.0000>: T  

Specify angle of taper for extrusion <0>: 45 

Specify height of extrusion or [Direction/Path/Taper angle] <1.0000>: 50 

Here is what you should have (a pyramid): 

 

Use the 3DORBIT command to view it at different angles (Click on the screen, hold 

the button down and move the cursor around the screen). Try extruding different 
shapes with various taper angles for more practices. 

These options give you a lot of versatility within one command. You may not use 
these options very often in your everyday drafting, but they're good to know.  
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LOFTING 

New in AutoCAD 2007 (and long overdue) is the LOFT command. The loft command 

is similar to the extrude command, but much more versatile. Instead of extruding a 

single shape, the loft command allows you to extrude several shapes and make one 
continuous object. 

Here's an example of how it works, I have drawn several shapes and aligned them 

with the same centre. Next, they were copied above and below the largest circle. The 

goal is to create a smooth object from the 7 profiles shown below. 

 

Here is a front view of the objects before and after the loft command: 

 

The example above is very simple, but thinks of how you can create complex shapes 
using this simple command. 

USING THE LOFT COMMAND 

The goal of this exercise is to create a "twisted Cube" - a 20x20x20 cube that looks 

like the top was twisted 45o. We're going to start with a simple one. Draw a square 

20x20. Copy it in the same place. Rotated the 2nd square 45o using the midpoints of 

the square as the base point. Finally, move the 2nd square up 20 units. You should 
have something like this from the SW view: 

From left to right, the original square, the copied and rotated square and the moved 
2nd square. Copy the 2 rectangles over (out of the way) to use in another exercise.  

 

 
Next you will create a lofted object from the 2 rectangles using the defaults.  

Command: LOFT  
Select cross-sections in lofting order: <SELECT BOTTOM SQUARE> 1 found 
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Select cross-sections in lofting order: <SELECT BOTTOM SQUARE> 1 found, 
2 total 

Select cross-sections in lofting order: <ENTER, Then Dialog appears>  

Enter an option [Guides/Path/Cross-sections only] <Cross-sections only> : 

<PRESS OK IN THE DIALOG>  

 

After hitting OK, you square will be turned into one lofted 3D Solid.  

Now something doesn't look quite right to me. I would expect that corners of the 

squares would be even so that the lofted square looks like a 'twisted cube'. Instead, 

you can see lines going from the middle of the bottom square to a corner of the top 

square. Use the HIDE command to see how it looks. It looks a little strange, but you 
can make out that it has some odd shapes. 

Take the pair of squares that you copied over earlier and draw lines from lower 
corner to upper corner as shown in the drawing below: 

 

Now start the LOFT command again. This time you'll try something different. Select 

the squares again as your cross sections, then instead of accepting the default, use 

the Guides option <G>. Now select the four lines which will guide the loft to create a 
shape that better represents what you want.  

Command: loft 
Select cross-sections in lofting order: 1 found 

Select cross-sections in lofting order: 1 found, 2 total 

Select cross-sections in lofting order:  

Enter an option [Guides/Path/Cross-sections only] <Cross-sections only>: 

G  
Select guide curves: 1 found 
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Select guide curves: 1 found, 2 total 

Select guide curves: 1 found, 3 total 

Select guide curves: 1 found, 4 total 

Select guide curves: <ENTER>  

Compare the 2 objects; the 2nd one should look more like the goal of a twisted cube. 

To change how you view things in AutoCAD 2007, use the VISUALSTYLES 

command. This new command allows you to quickly change settings for how you 
view 3D objects that previously needed the knowledge of several system variables. 

Use the settings highlighted below and press the "Apply to Current View port" 

button. You should now have a clear view that illustrated the differences between the 

first lofted object and the second one using guides.  

 

 

Try creating your own lofted 3D Solids. Anything that can be extruded can be lofted - 

so any closed shape will work. There are many other options to this command, but in 

a effort to be brief and cover the basics, I will not go further into this command. 

Remember to pick the cross sections in the correct order, add guides to better define 
the shape. 

In review, you can see how extruding and lofting are two simple commands that give 

you a lot of power in the 3D world. Get familiar with extruding, as it is a great way to 

build things in 3D. Lofting will allow you to create more 'organic' shaped that any 
previous version of AutoCAD.  
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REVOLVED OBJECTS 

Below is a sample drawing showing 2 different revolved objects. It will also be your 
goal in this lesson to duplicate similar objects. 

 

So far you've only worked with very basic blocks. Suppose that you need to draw 

something other than a rectangular cube. You did some new shapes in the previous 

lesson while lofting. AutoCAD gives you two commands for those times when you 

need to draw cylindrical objects. One (resurvey) will give you a complex model 

comprised of a 3-D surface made up of many facets. The other (revolve) will give 

you a solid object. The method that you use will once again depend on what you 

need it for. Take a look at the lamp on this page. This is an example of two different 

types of objects requiring two types of object construction. The lampshade is a 

'hollow' object. Essentially it's just a surface. The lamp base is a solid object. The 

resurvey command was used to create the lampshade, while the revolve command 

was used to create the base. It's not the greatest looking lamp ever, so in this 

lesson, you'll be designing a lamp base and a lampshade. You'll start by defining half 

the profile of each object, then revolving them. This will also be good practice for 
viewing your 3-D model.  

Begin a new drawing using the acad.dwt template.  

Create 2 layers called SHADE and BASE and give them different colors.  

Make BASE your current layer.  

Start the polyline command. Begin the profile for your lamp base. Use Ortho mode 

to draw a a backwards "C" shape with the vertical line 10 units up and the horizontal 

lines can be whatever you like (you're the designer now).  

Next draw a spline to connect the two ends of your polyline using Osnaps.  

Hint, when ending the spline command, you will be asked for the start and end 

vectors - choose the endpoint just to the right of your end in the vertical line.  

Draw a short vertical line as shown in step 3 (make sure Ortho mode is ON). 

Make SHADE your current layer Draw a short angled line as shown in step 4 (this is 
the beginning of the shade.) 

Make BASE your current layer. Start the REGION command and create a region 
from the lines that makeup the base. Don't include the vertical line at the top. 
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You have drawn everything you need for this lesson and will use modifying command 
to complete the lesson. 

First you'll create the lampshade. Before you do this, though, you'll have to set two 

of AutoCAD's system variables (SURFTAB1 & SURFTAB2). These variables control 

how many facets you'll have in your surface. The default is 6, which will give you a 

very chunky looking shade (like a hexagon instead of a circle). The number you pick 

will also influence how fast your computer can display the object as well as how 

round the shade will appear. The sample on the previous page had the SURFTAB1 
variable set to 24 to give the lamp 24 sides.  

To change these, type in SURFTAB1 at the command prompt enters 24. AutoCAD 

will show you the current setting and give you a chance to reset it. Set the variable 

and then set SURFTAB2 enter 2 for this variable. Since the vertical shape is a 

straight line, you only a setting of 2 (the minimum). 

Now you're ready to create the lampshade. Start the REVSURF command. 

You will be asked to select the path curve. This is the line that represents the 

lampshade. Then you are asked to select the axis of revolution. Pick the 

vertical line that you drew. Accept the defaults of 0 for the start angle and 

full circle for the included angle. This will rotate your line a full 360 degrees. 

Command: REVSURF 

Current wire frame density: SURFTAB1=24 SURFTAB2=2 

Select object to revolve: <pick the lampshade line> 

Select object that defines the axis of revolution: <pick the vertical line> 

Specify start angle <0> : <ENTER>  
Specify included angle (+=ccw, -=cw) <360> : <ENTER>  

You'll see that the lampshade looks like a lampshade now. 

Next you will create the base. Start the REVOLVE command. You'll be asked to 

select objects. Pick the region for the lamp base. Next you're asked to select the axis 

of rotation. With your endpoint Osnap on, pick the top and bottom of the vertical 

line. Accept the default of <full circle> for the angle of revolution. This will revolve 
the profile around the vertical line 360 degrees and create a solid object. 

Command: REV REVOLVE 

Current wire frame density: ISOLINES=4 

Select objects: <select the region> 1 found 

Select objects: <ENTER>  

Specify start point for axis of revolution or 

define axis by [Object/X (axis)/Y (axis)]: O <ENTER> 

Select an object: <SELECT THE VERTICAL LINE ABOVE THE BASE>  
Specify angle of revolution <360> : <ENTER> 
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VIEWING YOUR LAMP 

Use the HIDE (HI) command to see that you really have 3D objects and that the 
shade blocks the top part of the base. 

If you switch to your SW Isometric view, you'll see that the lamp is ‘on its side'. To 

arrange it to be sitting on its base, you will have to use the ROTATE3D command. 

Begin the command by typing ROTATE3D and select the objects that you want to 

modify and press enter. By accepting to default of 2points, you are going to tell 

AutoCAD what axis you want the lamp rotated about. Pick the points as shown in the 

example below. Make sure you have your Osnaps (Quadrant) on. Refer to the right 
hand rule for the correct rotation angle. 

Command: ROTATED3D  

Current positive angle: ANGDIR=counterclockwise ANGBASE=0 

Select objects: Specify opposite corner: 2 found 

Select objects: <ENTER>  

Specify first point on axis or define axis by  

[Object/Last/View/Xaxis/Yaxis/Zaxis/2points]: <PICK POINT 1> 

Specify second point on axis: <PICK POINT 2> 
Specify rotation angle or [Reference]: 90 <ENTER>  

 

Now that you have your own 3D model, try some of the viewing options described in 
Lesson 3-4.  

Save your drawing as cool_3d_lamp.dwg as you will need it in a later lesson.  

http://www.we-r-here.com/cad/tutorials/level_3/3-3.htm#rotate3d
http://www.we-r-here.com/cad/tutorials/level_3/3-3.htm#rotate3d
http://www.we-r-here.com/cad/tutorials/level_3/3-4.htm
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ADDING MATERIALS 

One of the more interesting aspects of working in 3-D is that you can visualize what 

your design will look like. You have so far used the hide and shade commands to 

give you some idea towards how the final piece will look. The next step is to learn 

about the RENDER command. This command is the most powerful one for viewing 

your objects. Using render, you are able to add realistic lighting and materials to get 

the most realistic view of what you're designing. 

You can render objects that don't have materials applied to them, but it won't look 
as realistic as if you have material added. 

The first two blocks shown here are examples of the usual wire-frame view before 
and after the HIDE command. 

 

These two blocks show how the render command can show the object two ways. The 

block on the left was rendered without a material applied, while the one on the right 
has a white ash material applied. 

 

Applying the materials is a relatively easy process, getting them to look exactly the 

way you want them to can be a skill in itself. Once the materials are added, getting 

the lights and shadows to look realistic is another task that most people prefer to 
complete in a program other than AutoCAD. 

Follow these steps to get an basic, accurate rendering: 

 Draw the object using solids or surfaces 

 Apply the materials 
 Render the scene 

Once your objects are drawn, you have to decide which materials you want to use. 

AutoCAD comes with a basic materials library that you can use to apply to your 
objects.  

Later lessons will teach you how to create new materials and map them to objects. 

This lesson is designed to allow you to quickly and easily apply materials to your 
objects.  

Start by drawing a basic cube 20x20x20 - this will be your object for testing 

materials. Go to the Tools Menu and select Tools > Workspaces > 3D Modeling. You 

http://www.we-r-here.com/cad/tutorials/level_3/3-14.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-13.htm
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will see that two new palettes are added. Close the one on the right for drawing and 
leave the one that contains a list of materials.  

Now that you have your object (the cube) and a list of materials, you're ready to go. 

To add a material to the cube, click on the icon of the material you want to use. 

Move your cursor into the drawing area and your cursor should change to this one: 

 

Just move the new cursor over the cube until it is highlighted and click on it. Press 

<Enter> to end the command. It will look like absolutely nothing happened. You may 

have even done it a couple time to try and make it work. The only way to confirm 

that the material is attached to the cube is to 'render the scene'. This is easy - just 

type in Render and presee enter. You'll see that a new window opened and rendered 

your cube. 

 

Use these commands to apply materials to the lamp that you drew in Lesson 7, and 

other solid objects you have drawn. Materials cannot be applied to wire frame 
objects or those drawn with line thickness. 

For even more realistic looking materials, you may have to map them as shown in 
Lesson 3-13. 

Adding materials is a very simple process. Getting them to look exactly as you want 

or life-like can take some time to perfect. It is a combination of material, mapping 
and lighting. 

http://www.we-r-here.com/cad/tutorials/level_3/3-7.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-13.htm
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PRIMITIVE SOLIDS 

What is a Primitive Solid? 

A primitive solid is a ‘building block' that you can use to work with in 3D. Rather than 

extruding or revolving an object, AutoCAD has some basic 3D shape commands at 

your disposal. From these basic primitives, you can start building your 3D models. In 

many cases, you get the same result from drawing circles and rectangles and then 

extruding them, but doing it one command is generally faster. Using these with 

Boolean operations can be a very effective way of drawing in 3D. There are 6 six 
different shapes that you can choose from: 

(Click on the ICON below to go to the command) 

SHAPE  COMMAND  ICON  DESCRIPTION  

BOX BOX 
 

Creates a solid box after you provide 2 opposite 

corners.  

SPHERE SPHERE 
 

Creates a solid sphere from a center point and 

radius.  

CYLINDER CYLINDER 
 

Creates a straight cylinder from a center point, 

radius and height.  

CONE CONE 
 

Creates a tapered cone from a center point, 

radius and height.  

WEDGE WEDGE 
 

Creates a triangular wedge from 2 opposite 

points.  

TORUS TORUS 
 

Creates a torus (donut shape) based on center 

point, radius and tube radius.  

POLYSOLID PSOLID 
 

Draws a solid object with width and height as 

would draw a polyline.  

You can use primitives to either begin building a model, or it can even be a finished 

object on its own. Many of these commands are similar to 2D commands, except 

with an extra co-ordinate in the Z axis. Here is a summary of working with these 
commands. 

BOX  

Think of a box as an extruded rectangle. It has width, height and depth. It is created 

by establishing a starting corner and then establishing a second corner by either 
picking or giving relative co-ordinates. 

Here is an example of this:  

http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#box#box
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#sphere#sphere
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#cylinder#cylinder
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#cone#cone
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#wedge#wedge
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#torus#torus
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#psolid#psolid
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Command: box 

Specify corner of box or [Center]: 2, 3, 4  

Specify corner or [Cube/Length]: @5, 7, and 10 

This draws a box that is 5 units in the X-axis wide, 7 units long in the Y-axis and has 

a depth of 10 units in the positive Z-axis with one corner located at 2, 3, 4. 

Here is another way of drawing that same box: 

Command: BOX 

Specify corner of box or [Center]: 2, 3, 4 

Specify corner or [Cube/Length]: @5, 7 
Specify height: 10 

Using this method, you establish the first corner as before, but only enter the X and 

Y co-ordinates of the opposite corner. AutoCAD will then prompt for the height. 

Another way of drawing a box is to establish where the center of the box will be: 

Command: BOX 

Specify corner of box or [Center] <0,0,0>: C 

Center of box <0,0,0>: <ENTER> or <PICK A POINT>  
Specify corner or [Cube/Length]: @2,3,4 

This draws a box that is 4x6x8 based about the center of 0, 0, and 0. 

If you want to draw a perfect cube, you can use this option: 

Command: BOX 

Specify corner of box or [Center] <0, 0, 0>: (pick point)  

Specify corner or [Cube/Length]: C 
Length: 4 

This draws a cube with all sides equal to 4 units based of off a picked point. 

The last way of drawing a cube allows you to enter the Length, Width and Height as 
separate distances, and not based on co-ordinate points. 

Command: BOX 

Center/<Corner of box> <0, 0, 0>:  

Cube/Length/<other corner>: L 

Length: 5 (X AXIS)  

Width: 4 (Y AXIS)  

Height: 6 (Z AXIS)  

Of course you can also draw a box by picking two opposite corners with your mouse. 

This is useful for filling in areas and can be very quick. Make sure to use your 
Osnaps. 
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SPHERE  

A Sphere is a globe-like shape. It is very similar to drawing a circle in that you pick a 

center point and then input either the radius (default) or diameter. Both methods 
draw the same sphere in the following examples: 

Command: SPHERE 

Specify center point or [3P/2P/Ttr] : <PICK POINT>  
Specify radius or [Diameter] <2.3756>: 6 <ENTER>  

 Command: SPHERE 

Specify center point or [3P/2P/Ttr] : <PICK POINT> 

Specify radius of sphere or [Diameter]: D 
Specify Diameter: 12  

Both of the above methods will give you the same result.  

You also have the options of selecting 3 Points, 2 Points, or using 2 tangents and 
radius (TTR).  

CYLINDER  

A cylinder is just like an extruded circle. Creating one is very similar to creating a 
circle, except that you are giving depth to it. 

These two examples would draw the same cylinder: 

Command: CYLINDER 

Current wire frame density: ISOLINES=4 

Specify center point for base of cylinder or [Elliptical] <0, 0, 0>:  

Diameter/<Radius>: 6 
Center of other end/<Height>: 4 

Command: CYLINDER 

Current wire frame density: ISOLINES=4 

Specify center point for base of cylinder or [Elliptical] <0, 0, 0>:  

Specify radius for base of cylinder or [Diameter]: D 

Diameter: 12 

Specify height of cylinder or [Center of other end]: 4 

CONE  

Drawing a cone is the same as drawing a cylinder, except that the resulting object 

tapers smoothly from the bottom to a point at the top. 
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Command: CONE 

Current wire frame density: ISOLINES=4 

Specify center point for base of cone or [Elliptical] <0, 0, 0>:  

Specify radius for base of cone or [Diameter]: 4 
Specify height of cone or [Apex]: 8 

Command: CONE 

Current wire frame density: ISOLINES=4 

Specify center point for base of cone or [Elliptical] <0, 0, 0>:  

Specify radius for base of cone or [Diameter]: D 

Specify diameter for base of cone: 8 
Apex/<Height>: 8 

Another way of drawing a cone is to enter in the center point, the radius (or 

diameter) and then establish where you want the apex (point of cone) to be. You can 
either type in co-ordinate points or pick a point with your cursor. 

 

Command: CONE 

Current wire frame density: ISOLINES=4 

Specify center point for base of cone or [Elliptical] <0, 0, 0> : <PICK>  

Specify radius for base of cone or [Diameter]: 5 

Specify height of cone or [Apex]: A 
Specify apex point: @5, 5, and 6 

WEDGE  

One of the trickier primitives to draw is the wedge. You have to be careful which co-

ordinates you input to make the wedge lay in the position you want. If it doesn't turn 

out just as you hoped for, you can always rotate it. 

Here is an example of drawing a wedge: 

Command: wedge 

Specify first corner of wedge or [Center] <0, 0, And 0> : <PICK> 
Specify corner or [Cube/Length]: @5, 2, and 4 

Once the first corner is established, you can either enter points, or pick a spot. 

AutoCAD will draw the shape like it would draw a cube except it is slice in half along 

the length starting at the point above the first corner. There are other options to 

drawing wedges and see the box examples for these.  
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TORUS  

A torus is a donut-like shape or something resembling an inner tube. When drawing 

one you have to enter the center point, a radius to the center of the tube and the 
radius of the tube itself. 

Command: TORUS 

Current wire frame density: ISOLINES=4 

Specify center of torus <0, 0, 0>:  

Specify radius of torus or [Diameter]: 3 
Specify radius of tube or [Diameter]:.25 

The diagram on the right shows the resulting diameters from the input above. A 
center mark indicates the picked center of the torus. 

POLYSOLID  

This is a new command for AutoCAD 2007. A polysolid allows you to draw a solid 

object while defining the height and the width. I think this command is aimed at the 
architects, who will enjoy the ability to quickly draw solid walls. 

Command: PSOLID  

POLYSOLID Specify start point or [Object/Height/Width/Justify] <Object>: 

H  

Specify height <96.0000>: 96 

Specify start point or [Object/Height/Width/Justify] <Object>: W  

Specify width <6.0000>: 6 

Specify start point or [Object/Height/Width/Justify] <Object>: J  

Enter justification [Left/Center/Right] <Center>: L  

Specify start point or [Object/Height/Width/Justify] <Object>: <Pick 1st 

point>  

REVIEW 

As mentioned in previous lessons, solids are usually the way to go with 3D CAD. 

Depending upon your chosen field, you may use 3D meshes in Civil Drafting, 

Isometric in HVAC, solids in mechanical, etc.  

I recommend getting used to solids if you are doing any kind of mechanical drafting 

or architectural drafting if you are using base AutoCAD software. When using solids, 

you will usually take a shape and extrude it - then use Boolean commands and 

others to edit it.  

http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm
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BOOLEAN OPERATIONS 

Working in 3D usually involves the use of solid objects. At times you may need to 

combine multiple parts into one, or remove sections from a solid. AutoCAD has some 

commands that make this easy for you. These are the Boolean operations as well as 
some other helpful commands for solids editing. 

COMMAND  INPUT ICON  DESCRIPTION  

UNION 

(Boolean) 
UNI  

 

Joins two or more solids into creating one 

based on the total geometry of all.  

SUBTRACT 

(Boolean) 
SU 

 

Subtracts one or more solids from another 

creating a solid based on the remaining 

geometry.  

INTERSECT 

(Boolean) 
IN  

 

Creates a single solid from one more solids 

based on the intersected geometry.  

EXTRUDE 

FACE  
SOLID EDIT  

 

Allows you to increase the size of a solid by 

extruding out one of its faces.  

SLICE SLICE none Slices a solid along a cutting plane.  

3D ALIGN  3DALIGN 
 

Aligns 2 3D Objects in 3D space.  

The Boolean commands work only on solids or regions. They are easy to work with IF 

you follow the command line prompts. Here is an example of each. 

Start these exercises by drawing a block 5W X 7L X 3H and a cylinder 3 units in 
diameter so that the center of the circle is on the midpoint of the block. 

UNION 

Below left, there is a box and a cylinder. These are two separate objects. If you want 
to combine them into one object, you have to use the union command. 

  

The UNION command combines one or more solid objects into one object. 

Here are the command line prompts and the resulting object: 

Command: union (PRESS ENTER)  

Select objects: (SELECT THE BLOCK) 1 found 

Select objects: (SELECT THE CYLINDER) 1 found 

Select objects: (PRESS ENTER) 

http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm#union#union
http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm#sub#sub
http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm#int#int
http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm#extface#extface
http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm#slice#slice
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NOTE: The object that you select first will determine the properties of the unioned 
object when it is created. 

SUBTRACT 

The subtract command is used to cut away, or remove the volume of one object 

from another. It is important to check the command line when using this command. 

Remember that AutoCAD always asks for the object that you are subtracting FROM 
first, and then it asks for the objects to subtract. Here is an example: 

  

The SUBTRACT command removes the volume of one or more solid objects 

from an object. 

Command: SUBTRACT 

Select solids and regions to subtract from... 

Select objects: (SELECT THE BLOCK) 1 found (PRESS ENTER)  

Select objects: Select solids and regions to subtract... 

Select objects: (SELECT THE CYLINDER) 1 found (PRESS ENTER)  
Select objects: (PRESS ENTER)  

INTERSECT 

This command creates a new solid from the intersecting volume of two or more 

solids or regions. AutoCAD will find where the two objects have an volume of 

interference and retain that area and discard the rest. Here is an example of this 
command: 

  

The INTERSECT command combines the volume of one or more solid objects at 

the areas of interference to create one solid object. 

Command: intersect 

Select objects: (SELECT THE BLOCK) 1 found 

Select objects: (SELECT THE CYLINDER) 1 found 

Select objects: (PRESS ENTER) 

Try these commands with various 3D solid objects to get familiar with them. Draw 

the block in Lesson 3-2. Draw the outline of the block, extrude it - then draw the 
circle and extrude it. Then subtract the circle from the block. 

These commands will allow you do a lot of 3D work, using only the extrude and 
these Boolean commands. Of course, there are some other ways to edit 3D solids. 

http://www.we-r-here.com/cad/tutorials/level_3/3-2.htm
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SLICE  

This command does exactly what the name implies. You can slice a 3D solid just like 
you were using a knife. 

Start with the basic block and cylinder shape you used in the examples above. 

 
 

The INTERSECT command combines the volume of one or more solid objects 

at the areas of interference to create one solid object. 

Command: slice 

Select objects: 1 found 

Select objects: Specify first point on slicing plane by  

[Object/Zaxis/View/XY/YZ/ZX/3points] <3points>: PICK POINT 1 

Specify second point on plane: PICK POINT 2  

Specify third point on plane: PICK POINT 3 

Specify a point on desired side of the plane or [keep Both sides]: Pick on the side 
towards the cylinder.  

This is a very useful command - think of it as a trim in 3D. Make sure you have your 

Osnaps on for this command and that you pick the correct points. In a complex 3D 

drawing, this can be tough to see. 

EXTRUDE FACE 

Just as there is a "trim"-like command in 3D - there is also a "stretch". This is a new 

command in recent versions.  

I usually start this command by clicking on the menu item Modify > Solids Editing > 
Extrude Faces. There is also an icon for it on the Solids Editing menu.  

The command is quite easy to use, but you need to be careful on which face you 
select. 

Try to extend one edge of the block by 1 inch. Start the command and pick the face 

on the side (on the bottom line). You'll notice that the bottom face highlights as well. 

Next type R and pick the bottom face to remove it. Then follow the command line to 
finish the command. 

Command: _solid edit 

Solids editing automatic checking: SOLIDCHECK=1 

Enter a solids editing option [Face/Edge/Body/Undo/exit] <exit>: _face 

Enter a face editing option  

[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/Undo/eXit] <exit>: _extrude 

Select faces or [Undo/Remove]: (PICK BOTTOM LINE OF SIDE FACE) 2 faces found. 

Select faces or [Undo/Remove/ALL]: R 
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Remove faces or [Undo/Add/ALL]: (PICK AN EDGE ON THE BOTTOM FACE) 2 faces 

found, 1 removed. 

Remove faces or [Undo/Add/ALL]: (ENTER)  

Specify height of extrusion or [Path]: 1 (ENTER)  

Specify angle of taper for extrusion <0>: (ENTER)  

Solid validation started. 

Solid validation completed. 

Enter a face editing option  
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/Undo/eXit] <exit>: (ENTER) 

You should end up with this: 

 

Another way of editing faces in AutoCAD 2007 is to use grips to extrude the faces, 

just like you would on a 2D object. Here is an image below that shows some of the 

grips available. This option is only available on the basic shapes shown in lesson 3-

10.  

 

3D ALIGN 

Sometimes, you may find it faster or easier to draw something separately and then 

move and align it into place. The command to use this in 3D is (funnily enough) 
3DALIGN.  

This is a simple example, but will show you the method. 

Draw a box that is 5 x 5 x 6 tall. Next draw a cylinder that is 3 in diameter and 1 tall. 
It should look like this: 

 

The goal will be to align the cylinder on the front face of the box where the dotted 
line is. 

Turn on your quadrant Osnaps. Start the 3DALIGN command. You will first be asked 
to select the objects - select the cylinder and press enter. 

http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm
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Now you will be asked to select the 3 points as indicated below: the centre and 2 

quadrants. Now the cylinder will be "stuck" to your cursor as AutoCAD asks where it 

needs to go. 

Line the cylinder up with the box by using object tracking to locate the centre of the 

face on the box first. Then pick on the midpoints to line up the cylinder to the box. 

After you pick the 3rd point, the cylinder should move into place and end the 
command. 

Here's a view of the points that were picked incase you had trouble. 

 

The finished 'alignment job' should look like this after using the hide command.  

 

Review:  

 

After learning how to draw some basic 3D solids, you can see that using equally 

basic editing commands you can have a lot of options. Before advancing, review 
these commands by drawing simple 3D shapes and editing them. 

With the commands explained on these pages, you will be able draw most of the 

shapes you will need in 3D. There are other options, but get very familiar with these 

3D editing options before moving on. The drawings done in the sample drawing 

section were done almost exclusively with the commands taught in Lessons 3-7 to 3-

11. You approach will make the project easy or difficult. Think of the various ways to 

draw an object before starting. You could save days with some forethought.  
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THE USER CO-ORDINATE SYSTEM (UCS) 

When working in 3D, it sometimes necessary to change the plane that you are 

drawing on. For example, if you need to add some detail to the side of a wall, you 

would want to draw on that plane. It's like taking a sheet of paper up off the floor 
(WCS) and taping it onto the wall (UCS). 

The WCS is the World Co-ordinate System. This is the way that the standard X,Y and 

Z axis are directed when you begin a new drawing (X to the right, Y pointing up and 

Z pointing towards you). The UCS is the User Co-ordinate System. This is a 
‘redirection' of the WCS based on parameters set by the AutoCAD user. 

There are several ways of doing this, and we'll look at an example here. 

 

This is a simple shape drawn on the WCS with one corner located at 0, 0, and 0. 

Here is the same object shown a new UCS based on the side of the object, so that 

you are enabled to draw a rectangle on that side: 

 

Notice that the positive X Axis is now pointing along the side of the house.  

Here's how it was changed: You first choose the 3 point option by typing 3 at the 

prompt. Next you have to pick three points to define the plane. The first point is the 

new origin. The second point is where you want the positive X-axis to be positioned. 

The last point is for the positive Y-Axis. 

Command: us 

Current us name: *NO NAME* 

Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]  

<World>: 3 

Specify new origin point <0,0,0>: (P1) 

Specify point on positive portion of X-axis <1.0000,7.0000,0.0000>: (P2)  

Specify point on positive-Y portion of the UCS XY plane 

<1.0000,7.0000,0.0000>: (P3) 
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This is the ‘3-Point' option of the UCS Command. It is one of the most useful, 

because you control exactly where the new drawing plane will be. You must also be 

extremely careful when picking the 3 points, or your plane can be shifted and cause 

some major problems. I would recommend using this method for most of your UCS 

work - or at least get very comfortable with it before moving on to other methods. 

NOTE: Pressing enter immediately after entering the UCS command accepts 
the default of returning to the WCS. 

Here are the other options of the UCS command. 

ORIGIN: 

Command: UCS 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 
/<World>: O Origin point <0, 0, and 0>: 

This option moves the UCS based on a newly picked origin point. It does not shift the 

drawing plane at all as you only pick one point. 

Z-AXIS: 

Command: UCS 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 

/<World>: ZA 

Origin point <0, 0, 0>:  

Point on positive portion of Z-axis <-8.0000, 0.0000, 1.0000>: 

This choice allows you to pick two points. First you pick the new origin, and then you 
pick a point for the positive Z-Axis. Make sure you type ZA to choose this option. 

OBJECT: 

Command: ucs 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 

/<World>: OB 

Select object to align UCS: 

Using this method, you have to pick on a 2D object that is lying on a particular 

drawing plane. This gets tricky, as you have to be aware how your positive X and Y 
axes end up. 

 



Dot Technologies, Gandhinagar 

 114 

VIEW: 

Command: UCS 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 
/<World>: V 

By choosing the view option, AutoCAD will automatically reset the UCS to be aligned 

with your current view, keeping the origin where it was previously located. 

X / Y / Z: 

Command: UCS 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 

/<World>: X 
Rotation angle about X axis <0>: -90 

By selecting either the X, Y or Z options, you need to first pick a point along the axis 

you have chosen, and then provide a rotation angle based on the right hand rule 
mentioned earlier. 

PREVIOUS: 

Command: UCS 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 
/<World>: P 

This option returns you to the last setting you had for the UCS. 

Restore/Save/Del/? / 

The next options are used in conjunction with each other. You have the option of 

saving a particular UCS with a name. You can then restore that named UCS or delete 

if you no longer will be using it. Here are examples of these options: 

Command:UCS 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 

/<World>: S 

? /Desired UCS name: VIEW1 

Command:UCS 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 

/<World>: R 
? /Name of UCS to restore: view1 

Command: UCS 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/? 

/<World>:  

UCS name(s) to list <*>:  

Current UCS: VIEW1 

Saved coordinate systems: 
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VIEW1 

Origin = <0.0000,0.0000,0.0000>, X Axis = <1.0000,0.0000,0.0000> 

Y Axis = <0.0000,1.0000,0.0000>, Z Axis = <0.0000,0.0000,1.0000> 

Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/?/<Wor

ld>: D 

UCS name(s) to delete <none>: view1 

Deleted 1 UCS name. 

This was a series where a view was saved, restored, listed, and then deleted. 

Other notes about the UCS: 

Be careful when choosing a UCS. Look to the UCS icon and see that it is aligned the 

way you want it to be. Look for a clean vertical lines if it should be aligned along a 
vertical plane. 

Always be aware of where your UCS is located. Make sure that positive X is where 
you expect it to be. 
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MAPPING MATERIALS 

Whenever you are attaching materials to an object in AutoCAD, you are effectively 

‘stretching' the image of the material around the object. For many objects, this can 

be acceptable. For a lot of others, though, you may want to adjust how the material 

is displayed on the object. This process is called mapping. The commands in this 
lesson replace the SETUV commands used in previous versions of AutoCAD.  

Here is an example of the same object with the same material, but with the mapping 

of the material adjusted on the right-side object. 

 

By default, AutoCAD will apply the material as it sees fit. In this example above, the 

scale of the material is too small. To properly render the block, mapping is used to 

adjust and fine tune the material so that it looks the way you want it to appear. With 
a little knowledge of this command, you can make your renderings more realistic.  

Here are the commands needed for mapping your materials: 

COMMAND OR INPUT  ICON  DESCRIPTION  

MATERIALMAP  None 
Enter this on the command line to select 

mapping options via keyboard.  

Planar Mapping  
 

Maps individual faces of an object.  

Box Mapping  
 

Maps any solid object with controls for width, 

depth and height as well as rotation on all 

sides.  

Sphere Mapping  
 

Allows you to map any solid object, but uses 

rotation only.  

Cylinder mapping  
 

Maps a solid object with height and rotation 

only.  

Note also that the mapping icons are available on the render toolbar as a flyout. This 

lesson will explain each of the mapping options using the icons. To make the 

mapping toolbar appear, right-click on any toolbar and click on the mapping option in 
the list.  

http://www.we-r-here.com/cad/tutorials/level_3/3-13.htm#sub#sub
http://www.we-r-here.com/cad/tutorials/level_3/3-13.htm#int#int
http://www.we-r-here.com/cad/tutorials/level_3/3-13.htm#extface#extface
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Start by selecting the menu option Tools > Palettes > Tool Palettes (or CTRL+3) and 

you will see a large palette appear that includes the default material library.  

 

The palette you have just opened 

contains all the default palettes in 

AutoCAD. You may or may not see the 

one you need when you open them up 

this way.  

The palette you want for this exercise 

is the one called "Masonry - Materials 
Library".  

If you don't see it, click in the area 

shown by the red box in the image to 

the left. This will display a list of all 

palettes available. Select the one 

needed for this exercise and it should 

then look like the one shown on the 

left.  

Start by drawing a box that is 120x120x240 high and do a Zoom>Extents. Set your 

visual style to Realistic (Menu: View > Visual Styles > Realistic). Switch to the SW 

ISO view.  

As shown in lesson 3-9 apply the material called "Masonry.Stone.Limestone.Rubble." 

to the box. Depending upon your settings it may look something like this in a default 
view. 

 

In this view, it looks like the 'rubble' of the material is made up of small rocks that 

you can't really see clearly. What you want to create in this exercise is a 'box of large 
visible rubble'.  

http://www.we-r-here.com/cad/tutorials/level_3/3-9.htm
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We'll start with the BOX MAPPING icon and then select the box and press enter. 

You should now see some new grips on your object (this are different from the grips 

that allow you to adjust the size of an object.  

 

The left box shows the default 

mapping grips available with the 

box option.  

  The right box shows the added options 

when the rotate option (R) is selected on 

the command line.  

With the grips active, you will need to make the map larger by selecting the mapping 

grips one at time to make the material bounding box (in yellow) larger. Once you 

have finished moving a grip, click in the drawing space to release it. Note that there 

is one on the top as well (for height) as well as the four at the bottom. When you are 

happy with the look, press enter to end the command. Your new and improved box 

could look something like the one on the right: 

 

As you can see, the one on the right looks better than the default on the left. 

Now start the Box Mapping option again, and type in R <ENTER> to invoke the 

rotate option. You should now see the circular grips as shown two images above. To 

rotate the map, move your mouse over one of the circles and it will change color. 

Click and you will be able to rotate the material around the axis you chose. 

 

From these simple options, you can control the look of any material on any object. 
Ultimately, the look of your final rendering is the choice of you - the designer. 

The image below shows the options below for the cylindrical and spherical mapping 
commands: 
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The left image shows the options 

available with the spherical 

mapping command. Note that it is 

limited to Rotation and Moving.  

  The right image shows the options of the 

cylindrical mapping command. It is limited to 

rotation and height adjustment.  

Try the two mapping methods shown above on a sphere and cylinder. Then try using 

the Box Mapping command on those objects. You may find that in common usage, 

the Box Mapping method will provide you with the most versatile options to achieve 

the look you want. 

PLANAR MAPPING 

The other option not discussed yet is the PLANAR MAPPING command. It works a 

little differently than the others in that adjust the material on one face only instead 
of the whole object. 

Draw a cube 120x120x120. Apply a material to it that has some contrast to it so you 
can see the results clearly. 

Start the Planar Mapping Command using this icon:  

Instead of just selecting an object, press the Control Key as you click the box and 

you will see that only one face is highlighted. Click on the face that you want to map. 

From there, you will see that you have the same resize and rotate grips available to 
you, but will only affect the one face you selected.  

For practice, try mapping several different materials onto various objects of different 

sizes. You will need to get very familiar with this concept to produce decent 

renderings.  

http://www.we-r-here.com/cad/tutorials/level_3/3-13.htm#sub#sub
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CREATING NEW MATERIALS 

Once you start working with AutoCAD's materials, you'll soon realize that you don't 

really have a large selection. What is you need a white stucco material for a wall? Or 

grass for the lawn, or brushed aluminum, or... well, you get the picture. What you 
need to do is create your own materials. 

But what if want something totally different? Then you have to make a new material. 

The first step is to locate an image that represents the material you want in your 

drawing. There are a number of sources available on the internet. Check out the 
links page for some. Below are 3 samples you can try for this lesson.  

Metal Sample  Brick Sample  Wood Sample  

   

Pick on any of the images above and when the new window opens, right click on the 

large image and select "Save image as..." and save it in a folder where you can find 

it easily. 

Now start the MATERIALS command to open the Materials Palette.  

 

At first glance, this will look very 

different if you are used to 

previous versions of AutoCAD. If 

you have used 3D Studio MAX, 

then it may look familiar.  

Palettes are used in AutoCAD in 

much the same way as dialog 

boxes. A big difference is that they 

can be left on the screen while you 

are drawing. You can expand or 

collapse a palette by clicking the < 

or > buttons on the bottom left. 

Close it by clicking the X on the top 
left corner.  

In the top section of the palette is 

the materials used in the drawing 

shown as balls in default view. 

Below are buttons you will be using 

to work with the material, and at 

the bottom is a section for editing 
the material. 

I will take you through the simple 

http://www.we-r-here.com/cad/links/index.htm
http://www.we-r-here.com/cad/tutorials/level_3/links/metal33.jpg
http://www.we-r-here.com/cad/tutorials/level_3/links/stone03.jpg
http://www.we-r-here.com/cad/tutorials/level_3/links/wood30.jpg
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process of creating a material from 

an image file and applying it to and 

an object in your drawing. Then 

you will learn how to modify the 
material. 

Other lessons will give you more 

information on mapping the 

material to an object.  

To create a new material from one of the images from above (or another texture) 

open the materials palette and click New Material button.  This will open a dialog 

for naming. 

 

Give it a good name and description (start with good habits) and press OK. Now you 

are back in the Materials Palette. Click on the Select button in the diffuse map 
section: 

 

You should notice a new ball in the top section that has the material mapped to it. 

The clarity of the material will depend on its contrast in the image and the size of the 

ball in the top section. 

Now is the east part. Draw a solid object of some kind. Highlight your new material 

by clicking on the ball. Next click the Apply Material to object button . Finally, 

select the object. 

If everything looks right, great. If not, you may have to use the mapping tools you 
learned in Lesson 3-13 to adjust the material to your liking.  

Another option to get the materials set in scale to the object is to use the "Scale to 

Object" setting in the Materials Palette. This is found after you have created a new 

material next to the Select... button which will open up the Adjust Bitmap dialog 
(formally found in the SETUV command).  

http://www.we-r-here.com/cad/tutorials/level_3/3-13.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-13.htm
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This will help get the scale close to what you want it to be, of course this depends on 

the size of your original image file (as a rule, larger files are better as you can scale 

them down and retain clarity). This dialog box also allows for more settings, but each 

will apply to your own specific needs and image files. Try different settings and check 
the results.  

To make the material transparent or translucent, move the opacity slider on the 

Materials Palette to about 50 - making the material 50% transparent. You can adjust 
other options as shown in this dialog box. 

This is just an introduction to the world of creating new materials. If you have a 

photo editing program like Photoshop, Gimp shop (it's free) or another, you will be 
able to adjust the image files to fit your needs.  

For practice, here is good way to get graphics into your renderings. Draw an octagon 

(POLYGON command) and turn it into a REGION. Then create a new material using 

this image of a stop sign and apply it to the region. You will most likely have to 

adjust map settings to make it look good (or use the scale to object option shown 

above). For even more fun, add a wooden pole to it and use 3DROTATE to make it 
stand up properly.  

For more practice, try downloading some images or using ones that you already have 

and apply them to objects. Use the mapping tools to adjust them.  

There is only one way to get better at AutoCAD and that is to practice. In 3D, you 

not only need to know the commands, but also how best to use them. As you start 

drawing in 3D, you may start looking at everyday objects and think about how they 

would be drawn. Look at the sample drawing page and think about how they were 

done - using only the commands shown in this level.  

EXTRA PROJECT - A 

If you have finished the previous exercises and would like more practice, try this: 

http://www.gimpshop.net/
http://www.we-r-here.com/cad/tutorials/level_3/links/stop_sign.jpg


Dot Technologies, Gandhinagar 

 123 

Sketch out a simple coffee table on paper. Add the basic dimensions. Draw this in 

AutoCAD using any 3-D method. Once you've done this, draw another lamp and 

place it on the table. Use rotate3d if you need to turn it right-side up. Find a good 
view to display what you have drawn. Add materials.  

EXTRA PROJECT - B 

Take your file from Lesson 3-7 that gave you a solid model and use the fillet and 
chamfer commands to add some smoother corners to your chair. 

EXTRA PROJECT - C 

Draw the object that you draw in the isometric lesson in 3-D using extruded regions. 

You will have to first create the outline, then the circle. Turn both objects into 

regions. Subtract the circle from the outline to have one remaining region. Extrude 

this to get your solid object. 

TUTORIAL - CREATING A 3D OBJECT FROM A 2D PROFILE 

For this tutorial, you should be familiar with these commands: region, extrude, 
union, subtract. 

This tutorial shows you a method for quickly turning 2D shapes into 3D objects. One 

of biggest problems with 2D objects is that they are not always drawn properly. This 

is something that should have been addressed when it was first drawn, but here is a 

way of working around it. 

First let’s start with a basic shape. This is the profile for a gasket. It is drawn in 2D 
with lines, arc and circles.  

 

If it was well drawn, meaning no overlapping lines, gaps, etc. Here is how you do it. 

Start the REGION command. Draw a crossing window around the whole area and 

press enter. Once you have your regions created, you can extrude them. Start the 

EXTRUDE command and select all objects. Press enter and enter your extrusion 

height and taper angle. When these are extruded, begin your SUBTRACT command 

and first select the larger object first (to be subtracted from), press enter then select 

all the other objects and press enter. When you change to your SW Isometric view, 
type in HIDE (enter) and you should see the object as shown below. 

http://www.we-r-here.com/cad/tutorials/level_3/3-7.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-2.htm
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Remember that you can always work in your SW Isometric view to see the progress 
of your 3D work. 

There is one problem when using the REGION command. If have two lines that are 

overlapping, AutoCAD can not make a region out of the objects. You could search 

until find the offending line, but there is an easier way. Here's this approach: 

Instead of using the region command, use the BPOLY command. This command 

works similar to the HATCH command in that it finds the boundaries for you. Start 
the command and you will see this dialog box come up: 

 

Accept the defaults and press on the Pick Points< button. In your drawing screen, 
pick an internal point as if you were hatching it and then press enter. 

Now start your EXTRUDE command and select the last (L) object created and 

extrude it. Now begin the SUBTRACT command and select the outside object, (press 

enter) then use a crossing box to select everything else and press enter. Use the 
HIDE command to ensure that everything is as it should be. 
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Topics covered in this Lesson: 

 

Application of the previous lessons 

If you have completed the previous lessons in this level, you now have the tools to 

create a large variety of objects in 3D. This lesson is designed to show how to create 

simple building in 3D from start to finish. 

Below is an image of the final building that is explained in this lesson. 

 

Start by setting your units to architectural (DDUNITS). Remember to create new 

layers for each type of objects you will draw (windows, doors, walls, roof, etc). Also 
use the "View > Visual Styles > Realistic" option when adding materials.  

Now draw the bases of the walls using the dimensions are shown below. You don't 

need to dimension it. Optionally, you can use the (new in AutoCAD 2007) 

POLYSOLID command.  

 

Now you will create regions out of all your wall lines. 

Command: REG <ENTER> REGION 

Select objects: <SELECT ALL THE LINES> Specify opposite corner: 7 found 

Select objects: <ENTER>  

3 loops extracted. 
3 Regions created. 

You should now have 3 regions. If you don't then it usually means the your lines 
don't meet. 

Next you are going to EXTRUDE the walls 9' high. 

http://www.we-r-here.com/cad/tutorials/level_3/3-10.htm#psolid
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Command: EXT <ENTER> EXTRUDE 

Current wire frame density: ISOLINES=4 

Select objects: <SELECT THE 3 REGIONS> Specify opposite corner: 3 found 

Select objects:  

Specify height of extrusion or [Path]: 9' <ENTER> 
Specify angle of taper for extrusion <0> : <ENTER> 

It should appear that nothing has happened. You will need to go to the SW Isometric 

view to see how the wall was extruded. Do this and then use the HIDE Command. 

Something doesn't look right. What you will need to do is subtract the 2 smaller 

regions from the larger region. You should see this result after the Subtract and Hide 
commands. 

 

Now it's starting to look like something. Your walls are almost complete. 

Next you will add a door or two. The first door, on the outside will be on the bottom 

left wall. Start by drawing a rectangle from the middle of the outside wall and the 

other corner @6, 36 - this will create the opening. Your rectangle should look like 

this 

 

 

Now you want to EXTRUDE the rectangle up 6'8" and SUBTRACT it from the wall. 

Create a door layer (or make it active if you already have one) and draw a rectangle 

in the door opening that is 3"x 3' - put it in the middle of the door opening. Extrude 
it 6'8". 

Now create a second door (and opening) on the inside wall parallel to the outside 

wall that is 32" wide. After you do that, the drawing should look like this from the 

SW Isometric view: 

http://www.we-r-here.com/cad/tutorials/level_3/3-4.htm
http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm#sub
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If you haven't saved your drawing yet, now would be a good time. 

Now you're going to add some windows. This will be done using a similar process as 
the door. You will create openings, and then add the window. 

Create 2 rectangles in the position shown below. 

 

EXTRUDE the window 36 inches. They move them up 3'8" in the Z axis. Remember 
your relative co-ordinates from Lesson 1-1? 

Command: M  

MOVE 

Select objects: 1 found 

Select objects: 1 found, 2 total 

Select objects: Specify base point or displacement: <PICK ANYWHERE ON 

SCREEN>  

Specify second point of  
displacement or <use first point as displacement>: @0, 0, 3’8 

Now mirror the bottom left box to the opposite wall (Note: It will be easier if you 

revert to the top view for the mirror command) and the upper box to the inside wall 

so you have the 4 boxes looking like this: 

 

http://www.we-r-here.com/cad/tutorials/level_1/1-1.htm#entering
http://www.we-r-here.com/cad/tutorials/level_1/1-6.htm#mirror
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Next, subtract the four window openings from the walls. After switching to SW 
Isometric view and using the hide command, your drawing should look like this: 

 

Now the window panes have to go in. Since this is a simple drawing, you just be 
putting in a plane of glass to represent the window. 

Create a new layer for windows. The easiest way to do this is just like you created 

the doors. Make the window 1" deep. Once again, start with the rectangle at the 

base of the window opening, extrude it the height of the window opening and move 

it into the centre. 

Once you have one window made, copy it to the other openings. Save your drawing 

and then type in SHADE and choose the G option. Your building should look like 
this: 

 

Wow - now you're getting there. Next you will add to the walls to make them the 

right pitch for the roof. 

First you will have to change your UCS. Start he UCS command and choose the 

3Point option by typing 3 <ENTER>. When prompted (watch the command line) 
select the points shown below: 

 

   

After you pick the third point, the cursor should turn on its side. Now you can draw 

on the side of the building. In this case, you will be drawing a triangular shape to 

represent the rest of the wall up to the roof. 

http://www.we-r-here.com/cad/tutorials/level_3/3-12.htm
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Draw a LINE from the middle of the top outside of the wall up 6'. Then draw a 

POLYLINE from one corner, to the next, to the top of the line and use the C option 

to close the polyline.  

Finally EXTRUDE the triangle -6" and then COPY the extruded object to the other 

side of the building. Erase the vertical line you drew. You should have something like 
this now: 

 

To finish the wall, perform a UNION (Lesson 3-11) between the triangular sections 
and the bottom wall.  

You're almost done now. You will need to draw the roof to complete the drawing. 

First you will need to change your UCS to align it with the slant of the roof. Use the 

points shown below - and be careful which endpoints you select. 

 

Now draw a RECTANGLE from the top left corner of the triangular shape to the 

bottom of the opposite corner of the other triangular shape. It should like the 
magenta rectangle below: 

 

http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm#union
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New EXTRUDE the rectangle 6". Then copy 12" down in the Y Axis and then copy it 
12" up in the Y Axis - when you have the 3 sections UNION them into one object.  

Change back to the WCS (UCS <ENTER><ENTER>) and mirror the roof object to the 

other side. Check that it looks correct by viewing the model from the left and from 

the front. 

 

The last thing to do is trim the excess pieces off the top of the roof where the two 
slabs intersect. This will be done using the SLICE command (Lesson 3-11). 

Go to the SW Isometric view. 

Start the SLICE command and select the roof section towards the back. Then when 

you are asked to pick three points on the slicing plane, select any three points on the 

top of the roof section at the front. 

Switch to the NW Isometric view and slice other roof section in the same manner. 
Check to see that your roof looks correct, and if it is, union the two roof objects now.  

Go to the WCS and copy the roof 12" in the Positive X Axis and 12 “in the Negative X 

Axis and then union all 3 roof objects. Your building should now look like the one 
below: 

 

Your building is complete. To add a lawn, draw a very large rectangle around the 

house at the same Z level as the bottom of the house. Then turn it into a region so 
that materials can be added later.  

Save the drawing, then if you like, add materials and render the final image. In the 

image at the top of the lesson, the door is detailed material. More detailed 

instructions for rendering will be found in Lesson 3-17.  

http://www.we-r-here.com/cad/tutorials/level_3/3-11.htm#edit
http://www.we-r-here.com/cad/tutorials/level_3/3-17.htm
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Here are the materials used for the rendering at the top of the page. You can 

download them and add them to your Textures folder. The door texture would be 

used like the stop sign you may have rendered in lesson 3-14.  

Door. Jpg | grey_roof_slate.jpg | grass. Jpg | stucco_white.jpg 

You can also try to add more detail to the building if you like. But now you can see 

that using a few commands (in this case about 12), you can draw decent looking 

models 

 
 
 
 
 
 
 
 
 
 
 

************************************ 

http://www.we-r-here.com/cad/tutorials/level_3/3-14.htm#stop
http://www.we-r-here.com/cad/tutorials/level_3/images/door.jpg
http://www.we-r-here.com/cad/tutorials/level_3/images/grey_roof_slate.jpg
http://www.we-r-here.com/cad/tutorials/level_3/images/grass.jpg
http://www.we-r-here.com/cad/tutorials/level_3/images/stucco_white.jpg

